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CREATING APPEARANCE FILES 1

Welcome to the PopChart Builder User Guide. This manual will help you create 
appearance files with PopChart Builder. 

If you are looking for something that will help you learn the basics of PopChart quickly, 
you may want to refer to the PopChart Quick Start manual. If you are looking for a 
reference on PopChart Server, PopChart XML, PCScript, or the PopChart Embedder 
APIs, you should refer to the PopChart Server Reference manual.

The material in this manual is very reference oriented. If, while you are in a PopChart 
Builder dialog, you have any questions about a certain option or feature, click on the Help 
button to find out more about that option or feature. You can also search for information on 
any given subject matter in the online help system or in the HTML version of the PopChart 
documentation. 

Over the next few months, we will be updating this documentation to make it more of a 
User Guide. Please visit the Corda Technologies website (http://www.corda.com) 
regularly for the latest documents.
PopChart Builder User Guide 1-1
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. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . W H A T  I S  P O P C H A R T ?

In a world of ever increasing information, perhaps no skill is more valuable than the ability 
to convey that information in the most understandable and accessible format possible. Raw 
data is no exception to this rule, yet because understanding raw data often involves wading 
through spreadsheet after spreadsheet in search of key figures and trends, it is often the 
hardest type of information to convey.

For that reason, data visualization is paramount. Graphs and charts can convey in a few 
seconds information that is often not clear even after hours of analyzing numbers. Data 
visualization is what Corda Technologies is all about. With our easy-to-use PopChart 
tools, you can translate your data into state-of-the-art PopChart images—eye-catching, 
high-resolution, and interactive data-driven graphics, such as the ones on the next page.

A PopChart image can contain a variety of charts and graphs, fed with on-demand dynamic 
data. It can include explanatory text boxes, callout notes, or PopUp text that appears as a 
viewer rolls over certain parts of the graph. It can even include interactive drill-down 
effects, such as linking to another PopChart image as a user clicks on a certain data item, or 
executing your own custom JavaScript™ functions.

As you read through this documentation, you will learn all about how you can utilize 
PopChart technology to convey your information. And, if you haven’t already, you will 
soon discover why PopChart is your all-purpose data visualization tool.

A B O U T  PopChart Builder

PopChart Builder is a graphical design tool that helps you design appearance files 
(templates) for PopChart images generated by PopChart Server. It includes a friendly 
PopChart Wizard, which will guide you through the process of creating an appearance file.

A B O U T  PopChart Server

PopChart Server does exactly what its name implies—that is, it serves images of charts 
and graphs. But these aren’t just run-of-the-mill static charts and graphs. These are dynamic 
and interactive images generated by PopChart Server on the fly. 

It works like this. You create an appearance file (kind of like a template for a graph) with 
PopChart Builder. Then, you send this appearance file to PopChart Server, along with 
data and formatting options, and PopChart Server returns a PopChart image—a graphical 
representation of your data, complete with PopUp text and the ability to drill-down to 
another graph that explains a data item in greater detail. 

The image can be in one of many different types of formats, including Macromedia® 
FLASH™, SVG™, PNG, GIF, PDF, EPS, WBMP, and even d link descriptive text for the 
visually impaired. You can also interface natively with PopChart Server in a variety of 
PopChart Builder User Guide
www.corda.com
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environments, from simple HTML to ColdFusion®; from Java™ Application Servers to 
Microsoft®’s .NET framework. PopChart Server can accept data from most database and 

Over 20 
different graph 
types, 
including Bars, 
Pies, Gauges, 
X-Y, Time, and 
Radar.

Data items drill-down to other 
web pages or PopCharts as 
the user clicks on them. Or 
you can execute a JavaScript 
function.

Crisp, colorful, 3D graphics in 
7 different formats, including 
FLASH, GIF, SVG, and PDF.

Data can be 
dynamic or 
static. 
PopChart also 
supports XML!
PopChart Builder User Guide 1-3
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data file formats. It even supports XML, making PopChart Server easy to integrate with 
your existing database system.

PopChart Server is the fastest, most robust, and most versatile data visualization and 
charting tool on the market today. Best of all, because PopChart Server is written in 100% 
Java, it can run on any platform. No matter what environment you operate in, you can take 
advantage of PopChart Server’s patented DataFunnel™ technology to deploy the latest in 
state-of-the-art interactive data-driven graphics.

O T H E R  P O P C H A R T  T O O L S

In addition to PopChart Server, you may also be interested in the following PopChart 
tools:

P O P C H A R T  X P R E S S
For those looking to publish static PopChart images from their desktop, there’s PopChart 
Xpress, a program that can run on any operating system and is easy enough for even non-
technical employess to use. You simply choose a graph type in the PopChart Wizard, copy 
data from a spreadsheet program such as Microsoft Excel, select a few formatting options, 
and PopChart Xpress generates everything you need to publish an image of your graph on 
the web.

PopChart Xpress can be downloaded for evaluation or purchased from the Corda 
Technologies website at http://www.corda.com.
PopChart Builder User Guide
www.corda.com
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PopChart Builder is installed at the same time as PopChart Server.

To install PopChart Builder download the PopChart 4.0.5 installer from the Corda 
Technologies website (http://www.corda.com) and follow the directions outlined in 
Chapter 2, “Installation,” of the PopChart Server User Guide. 

When you reach the Choose Install Set screen, if you do not want to install PopChart 
Server, select Builder Only. Ignore any instructions that pertain only to PopChart 
Server.

When you are done installing PopChart Builder, you can run it by clicking on the 
PopChart Builder shortcut or by running the PopChartBuilder executable file in the bin 
folder of the Corda installation directory (users on UNIX® compatible systems may have 
to run sh PopChartBuilder.bin on the command prompt for the latter to work).

E V A L U A T I N G  PopChart Builder

When you run the PopChart installer without entering a license key, the installer will 
automatically generate an evaluation key for you. This evaluation key will allow you to use 
PopChart Builder normally for 15 days, with the following restriction:

• The words Builder: Evaluation Use Only will appear on any images that are based on 
appearance files generated by an evaluation version of PopChart Builder.

After the evaluation period is over, or if you enter an invalid license key when installing 
PopChart Builder, PopChart Builder will run in a non-licensed mode. In this mode, 
PopChart Builder is fully functional except for the following restrictions:

• You cannot save or preview your appearance files.

To remove these restrictions, select File > PopChart License and enter a valid license 
key. You can purchase a license for PopChart Builder from Corda Technologies by 
visiting their website at http://www.corda.com, or by calling their sales department at 
(801)-805-9500.
PopChart Builder User Guide 1-5
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Appearance files are one of the most important elements in PopChart images. They contain 
all of the information about what the graphs should look like—essentially providing 
PopChart Server with a template for the images it generates. 

You can create appearance files in PopChart Builder, an easy to use designer for graph 
generation. You can create an appearance file from scratch, or you can customize one from a 
template using the PopChart Wizard.

There are also several example appearance files in the examples/apfiles folder of your 
document root.

Appearance files are saved in a format called PopChart XML (see Chapter 10). This is a 
text-based format that you can easily manipulate in a text editor. PopChart XML is also 
flexible enough to allow you to modify or create your appearance file on the fly.

By default, PopChart Server expects to find its appearance files in its document root 
(chart_root). For organizational purposes, PopChart Builder saves these files in the 
apfiles subfolder of that directory. Appearance files have a .pcxml extension.

appearance files contain sample data to help you get a feel for what the graph will look like 
when it has real data in it. To make things simple for now, we will just use that sample data. 
In most cases, though, you will send live data to PopChart Server, which will be applied 
dynamically to the graphs in your appearance file. Although the data will change, 
PopChart Server will retain the layout and formatting options that you specified in your 
appearance file.

Because appearance files are merely templates for graphs, it is hard to know exactly how the 
resulting will graph will look when fed real data. For tips on creating an appearance file that 
will look good no matter what data is fed to it, you should refer to “Tips for Creating Good 
Appearance Files” on page 1-18.
PopChart Builder User Guide
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Creating an appearance file is easy with PopChart Builder. When you first start PopChart 
Builder, the PopChart Wizard will begin. The Wizard will guide you through the steps of 
building a basic appearance file.

U S I N G  T H E  W I Z A R D

You can start the appearance file with a standard graph type, such as Bar, Pie, Line, or 
Stock, or you can select a pre-defined template to customize. After you select the graph type 
or template, you will be given the option of customizing some of the more common 
features, such as the title, the legend, and the color theme. When you are done customizing 
your appearance file in the Wizard, click Finish.
PopChart Builder User Guide 1-7
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Note:  PopChart Builder allows you to preview your PopChart image in the three main image 
formats (FLASH, SVG, GIF/PNG) at any time in your default web browser. Just click on the 
preview button at the bottom of the Wizard. Outside of the Wizard, you can preview your 
PopChart image by clicking on the Preview  toolbar button or select File > 
Preview.

C U S T O M I Z I N G  Y O U R  A P P E A R A N C E  F I L E

When you click finish the PopChart Wizard, you will be brought to the main PopChart 
Builder designer. In this designer, you can further customize your appearance file. 

By clicking on the buttons at the top of the window, you can add more objects to your graph, 
including graphs, images, text boxes, and legends. 

By double-clicking on any object (or selecting options from the Properties pull-down 
menu), you can bring up dialogs that allow you to control more advanced features that aren’t 
available in the PopChart Wizard. 

While in the dialogs, if you have any questions about what a certain option or feature does, 
click on the help button. This will bring you to the PopChart Builder online help reference, 
which will answer all of your questions about appearance file features and options.

S A V I N G  Y O U R  A P P E A R A N C E  F I L E

When you are done customizing your appearance file, you can save your appearance file by 
selecting File > Save. Your appearance file will be saved in the chart_root/apfiles folder 
of your PopChart installation.

You can access this folder later by selecting the Builder Projects shortcut, which is in 
your Start Menu on Microsoft Windows®. If you want to make changes to your 
appearance file, simply double-click on it and it will open in PopChart Builder.

Note:  If double-clicking does not open your appearance file, start PopChart Builder, select File 
> Open, and locate the file you want to edit.
PopChart Builder User Guide
www.corda.com
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T E S T I N G  T H E  A P P E A R A N C E  F I L E  W I T H  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . T H E  E X A M P L E  C O D E

One of the many convenient features of PopChart Builder is that it will automatically 
generate code to embed a PopChart image for you. Simply load or create an appearance file, 
select File > Sample Code, and choose the type of example code that you want. A 
dialog with sample code that you can copy will pop up.

In this dialog, you have a variety of choices. you can generate example code for a variety of 
environments, including JSPs, ASPs, Servlets, JavaBeans, JavaScript, PHP pages, and just 
straight HTML. The dialog also allows you to specify important variables, such as PCScript 
and your server address.

In some cases, you can cut and paste this example code directly into a file on your web 
server and have it work immediately. Most of the time, though, you’ll want to customize 
this code further before publishing your PopChart image.

Either way, the sample code can save you a lot of time. And, of course, it’s a great learning 
tool.

To Test  the  Appearance  F i le  w i th  the JavaScr ip t  PopChart Embedder
These steps will help you test your appearance file with the example code generated for the 
JavaScript PopChart Embedder.
PopChart Builder User Guide 1-9
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1 Start PopChart Builder.

2 Create and save an appearance file (or load one).

3 Select File > Sample Code > Java.
PopChart Builder User Guide
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4 Under the Show Code For option, select JavaScript.

5 Click on the Copy Code to ClipBoard button.

6 Open up a new file in a text or HTML editor and paste the example code into the file.

7 Save the file to your computer as a web page (e.g. popchart.html).

8 Start PopChart Server on your computer.

9 View the web page that you saved in step 7.

If all goes well, you should see a PopChart image when you view the web page.

If you don’t see anything, make sure PopChart Server has been started, and that it is 
running at http://localhost:2001. If it is running on a different machine, change the 
PopChartServer URL value in the sample code dialog. Also be sure to upload the 
appearance file to the same location on that machine.

For more instructions on embedding PopChart images, refer to Chapter 4, “Embedding 
PopChart Images in a Web Page,” in the PopChart Server User Guide 
PopChart Builder User Guide 1-11
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This section contains information about some of the new advanced features in PopChart 
Builder. These topics include:

• Custom Data Label Formatting

• Global Drill-down Settings and Macros

• PopChart Notes

C U S T O M  D A T A  L A B E L  F O R M A T T I N G

Data Labels can now be customized using macros. For example, in previous versions you 
only had one option for displaying data labels: the number only. Now, using macros, instead 
of having a data label that says 43, you can have one that says Price: $43. When combined 
with showing data labels on rollover, customized data label formatting may virtually 
eliminate the need for PopUp Text.

Macros are text keywords that stand for a dynamic value, such as a series or category name, 
or a data value. By using macros, you can make it so that each data label contains 
information pertinent only to the data item it is associated with.

To customize your data labels, select a graph, right click on it, and select Data Label 
Properties. The Data Label Format (All Graphs Except Pie) text box lets you 
change the data label format. A list of available macros is shown below in the Value 
PopChart Builder User Guide
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keywords pull-down menu. You can insert any of these macros into the text box by 
selecting the macro and clicking in the Insert button.

For example, by default the data label format is simply %_VALUE. This will display only 
the data value in the data label. If you wanted the data label to display the data series name, 
followed by a colon, followed by the data value, followed by a dollar sign, you could 
change the data label format to %_SERIES_NAME: %_VALUE$.

Table 1.1 lists the available data label formatting macros.

TABLE 1.1  Data Label Macros

Macro Description Graphs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
%_BUBBLE_VALUE The value of the bubble in an X-Y or Time 

Bubble graph.
X-Y or Time 
Bubble

%_CATEGORY_NAME The name of the category that the data item 
belongs to.

All, except 
X-Y and 
Time Plot

%_CATEGORY_TOTAL The sum of all data values in the category to 
which the data item belongs (applies to 

Area, Bar, 
Line, Pareto, 
Pie, Radar

%_CLOSE_VALUE The close value for a high-low data item. Stock

%_GRAPH_TOTAL The sum of all data values in a bar, line, pie, or 
radar graph.

Area, Bar, 
Line, Pareto, 
Pie, Radar

%_HIGH_VALUE The high value for a high-low data item. Stock

%_LOW_VALUE The low value for a high-low data item. Stock

%_OPEN_VALUE The open value for a high-low data item. Stock

%_PERCENT_OF_CAT
EGORY

The data value represented as a percentage of the 
sum of all data values in its category.

Area, Bar, 
Line, Pareto, 
Pie, Radar

%_PERCENT_OF_TOT
AL

The data value represented as a percentage of the 
sum of all data values in the graph.

Area, Bar, 
Line, Pareto, 
Pie, Radar

%_SERIES_NAME The name of the data series that the data item 
belongs to.

All

%_TIME_VALUE The time value for a Time Plot data item. Time Plot

%_VALUE The value of the data item. Area, Bar, 
Line, Pareto, 
Pie, Radar

%_XVALUE The x value for an X-Y data item. X-Y

%_YVALUE The y value for an X-Y or Time Plot data item. X-Y, Time 
Plot
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You can also change the data label format for an individual data series. Simply edit the value 
in the Data Label Format text box of the Series Properties > Data Labels pane.

For information about dynamically changing the data label format, refer to “Drill-down 
Effects” on page 7-14 of the PopChart Server User Guide.

P A R E T O  D A T A  L A B E L S
Data labels on a pareto graph work just like data labels fro any other graph (...). However, 
since the bars typically indicate a different type of value (e.g. dollars) than the line 
(percentage), you need to “trick” your appearance file into displaying a different symbol for 
the data labels along the line.

For example, suppose you set your data label format to $%_VALUE. A data label along the 
bar would look much like you would expect it to (e.g. $43,000). However, a data label 
along the line would unfortunately also include the dollar sign. So, wehereas you would 
want the data label along the line to be labelled as a percentage (e.g. 43%), it would instead 
use the same data label format as the bar (e.g. $43). This, of course, is probably not what 
you want to happen.

To work around this problem, first set your global data label string (select Graph 
Properties > Data Labels in PopChart Builder) to the format that you want data labels 
along the line to use (e.g. %_VALUE%). Next, use the series data label override (select 
Series Properties > Data Leabels in PopChart Builder) to change the data label 
format of the bars (e.g. $%_VALUE). This should give you the correct data label format 
both for the pareto line and bars.

G L O B A L  D R I L L - D O W N  S E T T I N G S  A N D  M A C R O S

A graph’s global drill-down destination can be set in the Drill-down URL text box of the 
Graph Properties > Drill-down dialog pane. The global drill-down destination will be 
applied to any data item that does not have an individual drill-down destination set in either 
the Series Properties dialog, PopChart XML, or PCScript.

Like data labels, the global drill-down destination can also be customized using macros. In 
many cases, this may make it so that you no longer have to worry about setting drill-down 
effects for individual data items.

For example, you could set your global drill-down destination to 
morestats.jsp?%_SERIES_NAME. If a user clicks on any data item in the Blue series, 
PopChart Server will drill-down to the address morestats.jsp?Blue. 
PopChart Builder User Guide
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The Value keywords pull-down menu below the Drill-down URL box lists the 
available data macros. You can insert any of these macros by selecting the macro and 
clicking Insert. Table 1.2 lists the available drill-down macros.

For information about dynamically adding or changing drill-down text settings, refer to 
“Drill-down Effects” on page 7-14 of the PopChart Server User Guide

P O P C H A R T  N O T E S

A new feature in PopChart 4.0.5 is PopChart Notes. Notes are a combination of text boxes 
and PopUp text (in fact, another name for them is Sticky PopUp). Like PopUp text, they are 
attached to a specific data item. However, like text boxes they are always visible. Notes 
"call-out" from the data item—there is a leader line from the data item to the note box.

TABLE 1.2  Drill-down Macros

Macro Description Graphs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
%_CATEGORY_NAME The name of the category that the data 

item belongs to.
All, except X-Y 
and Time Plot

%_CATEGORY_NUMBER The number of the data series that the 
data item belongs to.

All, except X-Y 
and Time Plot

%_POINT_NUMBER The number of the data item in the data 
series (e.g, the first plot point=1).

X-Y and Time 
Plot

%_SERIES_NAME The name of the data series that the 
data item belongs to.

All

%_SERIES_NUMBER The number of the data series that the 
data item belongs to.

All
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The image below shows a PopChart image that uses notes. The appearance file for this 
image is located in chart_root/examples/apfiles/notetest.pcxml.

.

D Y N A M I C  P O P C H A R T  N O T E S
PopChart Notes can be added dynamically with the graph.AddNote() PCScript 
method, or the Note attribute of the PopChart XML Data element (refer to “PopChart 
Notes” on page 7-9 of the PopChart Server User Guide). You can change the way that 
dynamic Notes look in the Graph Properties > Notes dialog pane.

A T T A C H I N G  P O P C H A R T  N O T E S  T O  T E X T  B O X E S
With the graph.AddNote() PCScript, or the NoteTarget attribute of the PopChart 
XML Data element (refer to “PopChart Notes” on page 7-9 of the PopChart Server 
User Guide), you can also attach a note to a text box. When you do this, the text box 
becomes the PopChart Note. This allows you greater control over the placement of the note. 
It is also useful when you want several notes that have different formats than dynamically 
generated notes.

When you attach a Note to a text box, you may want to set the text box so that it will only 
appear if it is attached to a Note. This way, if you decide not to attach a Note to the text box, 
the text box will be invisible. To do this, go to the General pane of the Text Box 
Properties dialog and check the Only Display Textbox as a Note box.
PopChart Builder User Guide
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If you are creating text boxes for the sole purpose of using them as PopChart Notes, you 
may also want to consider creating static PopChart notes, which allow you to better see how 
the text box would look as a PopChart note, as well as set the Only Display Textbox as 
a Note option for you.

U S I N G  S T A T I C  P O P C H A R T  N O T E S
You can create static PopChart Notes in an appearance file by going to the Series 
Properties > Note Text dialog pane. Simply enter the text for a PopChart Note next to 
the data item that you want to attach the note to, then click OK. The Note will appear in the 
designer.

You can customize this static PopChart Note as if it were a text box. In fact, for all practical 
purposes, it is a text box. the first notebox will be named notebox1, the second will be 
named notebox2, and so on.

Static Notes will disappear from a PopChart image if you load new data into the graph. 
However, they will reappear if you dynamically add a PopChart Note and attach it to the 
note box.
PopChart Builder User Guide 1-17
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T I P S  F O R  C R E A T I N G  G O O D  

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A P P E A R A N C E  F I L E S

An important thing to remember when you are creating an appearance file is that you are not 
creating a static image; you are designing a template for dynamic charts and graphs. 
Because of that, the image that you see in PopChart Builder can often be very different 
from the image generated by PopChart Server.

You should consider the following factor when creating a well-designed PopChart 
appearance file:

• Object Names

• Appearance File Dimensions

• Sample Data

• Colors and Color Themes

• Dynamic Object Resizing and Repositioning

• Image Format

O B J E C T  N A M E S

In order to send dynamic data to and/or customize objects in an appearance file, each object 
must have its own unique name. You will use this name to reference the object when you 
send PCScript or PopChart XML commands to PopChart Server. For example, the 
PCScript command to modify the data inside a text box is:

textbox.SetText(My Title)

In this case, the name of the text box object is textbox. Were the name something else, 
like title, for instance, the command would be:

title.SetText(My Title)

Thus, it is important to know what your objects are named and to make sure there are no 
duplicate names. By default, PopChart Builder assigns each object a unique name. The 
first graph will be named graph, and all subsequent graphs will be named graph2, 
graph3, and so on. Text boxes and legends follow a similar naming scheme, except text 
boxes are based on the name textbox, and legends on the name legend.

You may want to change these names to something more easy to remember. For example, if 
you have pie graph named graph2 that you use to show voting percentages, a name like 
votingpie might be more suitable to your needs.
PopChart Builder User Guide
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To Change the  Name of  an  Object
1 Select the appropriate object.

2 Bring up the properties dialog for that object by either double-clicking on the object or 

selecting the appropriate option from the Properties menu.

3 Click on the Advanced tab.

4 Enter in the new object name in the box to the right of the words Object Name.

5 Save the settings by clicking on Apply or OK.

T I T L E  T E X T  B O X
One very important object is the title text box. The text box named title is always 
considered the title text box. When you display descriptive text, the contents of this text box 
will be used to determine the title of your graph.

To set  a  T i t le  Box  in  an  appearance  f i le
1 Select the text box that contains the project title.

2 Right-click on the text-box.

3 Select Set as Title.

This will change the object name to title. If another text box was previously set as the 
title text box, it will be given a different name.

A P P E A R A N C E  F I L E  D I M E N S I O N S

When you create an appearance file, you should always try to make sure that the dimensions 
of the appearance file are exactly the same as the dimensions of the images you want to 
output. Changing the dimensions of your appearance file dynamically can lead to reduced 
image quality or unexpected repositioning of your objects (see below).

To change the dimensions of your appearance file, you can either click and drag out a corner 
of the appearance file’s border in the PopChart Builder interface, or you can select 
Project Properties > General and change the Size in Designer values.

D Y N A M I C A L L Y  R E S I Z I N G  T H E  A P P E A R A N C E  F I L E
You can dynamically resize your PopChart images through the height and width 
PopChart Embedder attributes or the @_HEIGHT and @_WIDTH server commands. 
However, resizing PopChart images does not mean that the image will be scaled. It will 
simply enlarge or reduce the dimensions of your PopChart images. Objects may be 
repositioned if they are outside of the appearance files boundaries.

You can also scale your PopChart image with the htmlHeight and htmlWidth 
PopChart Embedder attributes. This not recommended if you are using the GIF or PNG 
image formats, as image quality will suffer.
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S A M P L E  D A T A

It is difficult to anticipate what or how much data will be put into your template. A graph 
that looks good with a very small sample data set may look horrible with twenty or thirty 
categories and series. Therefore, you should try to make your sample data set as close as 
possible to the data sets that you expect to be used with your appearance file.

To change your sample data, click on your graph and select Properties > Data Editor.

You may also want to test your template with a variety of data sets to make sure that it still 
looks good.

C O L O R S  A N D  C O L O R  T H E M E S

Set colors for all of your data series, not just the ones that you see in PopChart Builder. 
That way, if your user inputs more data series than you expected, you still have control over 
the colors in your graph. You can set these by changing the Series Colors buttons on the 
top half of your Graph Properties > Colors dialog. Alternatively, you may want to 
provide your user with color themes refer to Chapter 11, “Color Themes,” in the PopChart 
Server Reference manual.

D Y N A M I C  O B J E C T  R E S I Z I N G  A N D  
R E P O S I T I O N I N G

Because the data that you use with appearance files is dynamic, objects such as text boxes, 
legends, and graphs can grow to unexpected sizes. To compensate for that, PopChart 
Server can try to resize your objects. For example, If a text box doubles in height, 
overlapping with a graph, PopChart Server will shrink the graph to compensate. 

Most of this functionality is turned on by default. However, you may not want this behavior. 
For example, if you have a text box that you want to always stay the same size, you may 
need to turn off its Auto Size Adjustment option.

The following is an explanation of options that affect object repositioning. It is divided into 
the following topics:

• Global Repositioning Options

• Graph Resizing

• Legend Resizing

• Text Box Resizing

• Scale Label Adjustments
PopChart Builder User Guide
www.corda.com



. .
 . 

. .C R E A T I N G  A P P E A R A N C E  F I L E S

Tips for Creating Good Appearance Files

User Guide�	
	�
• Aligned Objects

• Anchored Objects

G L O B A L  R E P O S I T I O N I N G  O P T I O N S
In the Advanced pane of the Properties > Project Properties dialog, you will find 
the following global repositioning options. By default, they are all enabled.

A D J U S T  G R A P H  S I Z E  T O  P R E V E N T  O V E R L A P
If checked, this setting automatically resizes graph objects so that they do not overlap with 
other objects, such as text boxes, legends, and other graphs.

A U T O  R E S I Z E  T O  F I T  H E I G H T  A N D  W I D T H
If checked, this setting attempts to automatically resize the objects in the PopChart image so 
that they scale to the dimensions specified in the request to PopChart Server. This applies 
only when the height and width PopChart Embedder attributes or the @_HEIGHT 
and @_WIDTH server commands have been used.

Note:  PopChart Server will not resize any fonts, so you may not like the results you get with this 
setting if you shrink the dimensions of the appearance file.

K E E P  C O M P O N E N T S  W I T H I N  H E I G H T  A N D  W I D T H
If checked, this setting forces the appearance file to format itself so that all of its objects 
remain inside of its border. This setting is useful when dealing with dynamic data, as the 
legend and graph objects can grow to unanticipated sizes.

G R A P H  R E S I Z I N G
When you create a graph, all parts of the graph are placed within predefined boundaries. 
This includes everything on the grid area, as well as text, tick marks, and scales. 

By default, the data you provide is scaled to fit within these boundaries. This means that as 
the scales and scale label text grow, the grid area may shrink to compensate. However, you 
can set the tick marks and scales to be outside of these boundaries so that the grid area 
always remains the same size.

The following two settings, in the Graph Properties >General dialog affect boundary 
settings:

• Keep text and ticks within graph bounds. When selected, the grid area, 
gridlines, labels, and ticks will be placed within the bounds of the graph.

• Allow text and ticks outside of bounds. When selected, the graph bounds affect 
only the size of the grid area. Tick marks, scale labels, and text will be positioned outside 
the graph boundary.

If the label text is larger than the graph, you may want to select this option. Note that if 
the labels extend beyond the project border they will be cut off.
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This option is also beneficial when two graphs are combined (overlaid) for data 
comparisons. It allows you to easily align the grid areas.

The size of scale labels may also affect graph labels (see “Scale Label Adjustments” on 
page 1-22).

L E G E N D  R E S I Z I N G
A legend will never shrink in size.

By default, it also will never grow in size, even if it runs out of room to display legend 
items. However, you can change this behavior in the General pane of the Legend 
Properties dialog. Checking the Grow Vertically if Needed and Grow 
Horizontally if Needed boxes will allow the legend to grow vertically and horizontally, 
respectively. The Max Width and Max Height values place a limit on how much the 
legend can grow.

If, after trying to grow the legend, PopChart Server still cannot fit all of the items inside of 
the legend’s bounds, it will try to fit the items by adding additional columns to the graph. 
You can specify the maximum number of columns by checking the Set number of 
columns to option and entering a number in the text box to the right of the column.

If the legend items still do not fit, PopChart Server will shrink the legend font. you can set 
the minimum size of the legend font in the Minimum Font Size box.

As a last resort, PopChart Server will attempt to truncate the legend item. You can control 
how much of the legend item PopChart Server truncates by entering a value in the 
Truncate Down to X Characters box. The default value is 20.

T E X T  B O X  R E S I Z I N G
By default, text boxes will automatically shrink so that the text fits exactly within the box. 
besides the margin, which can be set in the General pane of the Text Box Properties 
dialog, there will be no space between the text and the text box border.

In the Auto Size Adjustment section of this same dialog, you disable this behavior by 
unchecking the Shrink to Width and Shrink to Height boxes, which allow the text box 
to shrink its width and shrink its height, respectively.

A text box cannot grow wider than the value of its Max Width option, which is 600 by 
default. However you cannot limit the amount a text box can grow vertically.

S C A L E  L A B E L  A D JU S T M E N T S
Depending on the number of categories in your graph, PopChart Server may have 
difficulty displaying all of the scales labels. When this happens, PopChart Server will try 
several actions to automatically accommodate the scale labels. 

You can control how PopChart Server adjusts the scale labels by checking or unchecking 
scale label adjustments in the Bottom Scale Properties > Label dialog pane. You can 
also make manual adjustments to the scale labels to prevent overlap; however, you are less 
likely to prevent overlap when you make these adjustments manually.
PopChart Builder User Guide
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A U T O M A T I C  S C A L E  L A B E L  A D J U S T M E N T
By default, PopChart Server will automatically try to adjust the scale labels to 
prevent overlap. If this option has been disabled, you can re-enable automatic scale 
adjustments by selecting As Needed as the value of the Perform the 
Following Adjustments option.

If overlap occurs, it will try to apply any rules that have been checked below in 
order to prevent overlap. It begins by applying the highest (closest to the top of the 
pane) checked rule. If that doesn’t work, it discards the rule and attempts to apply 
the next checked rule. It does this until it has exhausted its options. PopChart 
Server then attempts to apply the adjustments in tandem (i.e. Wrap Text and 
Shrink Font, Wrap Text and Stagger Labels, etc.) until it exhausts its 
options. If this fails, it attempts to apply the rules three at a time, and so on.

These are the adjustment options available to PopChart Server. You can disable 
any option by unchecking it.

W R A P  T E X T   When selected, PopChart Server will wrap the text in the scale 
label at the specified number of characters.

S H R I N K  F O N T  T O   When selected, PopChart Server will reduce the font of 
the scale label to the specified point size.

S T A G G E R  L A B E L S   When selected, PopChart Server will stagger the 
labels so that every other one appears on an alternating level. 

R O T A T E   When selected, scale labels will be rotated to try to make more room. 
They will be rotated to the number of degrees specified in the box to the right of this 
option.

S K I P  L A B E L S   When selected, certain labels will be skipped. The bar, line, 
area, or plot point will still be shown for that category, but the scale label will not. 

The graph will use the specified number to determine how many labels to skip. For 
example, if the value is 1, it will display every other label. If the value is 2, it will 
display every third label.

M A N U A L  S C A L E  L A B E L  A D J U S T M E N T S
You may always make the following adjustments to your scale labels. These 
options are shown at the top of the Bottom Scale Properties > Label dialog 
pane.

L I M I T  L A B E L  C H A R A C T E R  L E N G T H   This option limits the character 
length of each scale (category) label to the specified number. If the label is longer, it 
will truncate it and add a period on the end. This period counts as part of the 
character length. You can set different values for the length of regular labels and the 
length of rotated labels.
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F I R S T  L A B E L  T O  B E  D I S P L A Y E D   This specifies the first bottom scale 
label that will actually be shown.

You can also make any of the adjustments listed in “Automatic Scale Label 
Adjustment” above by disabling automatic scale adjustments and selecting the 
adjustment manually.

D I S A B L I N G  A U T O M A T I C  S C A L E  A D J U S T M E N T S
You can disable automatic scale adjustments by selecting Always as the value of 
the Perform the Following Adjustments option. When you do this, 
PopChart Server will do nothing to prevent the overlap of scale labels. 
Additionally, any scale label adjustments that are checked will always be applied, 
even if there is no overlap.

A L I G N E D  O B JE C T S
When you align a group of objects, you tell PopChart Server to shrink or grow these 
objects in such a manner that the objects will always be aligned with each other.

To a l ign ob jects
1 Select an object. 

2 Select the other object(s). These object(s) will be aligned to the first object.

3 Select Alignment from the menu bar or right-click the selected item to display the 

alignment options.

4 Specify the desired alignment option.

• Left. Aligns the second object, and any subsequently selected objects, with the left edge 
of the first selected object.

• Center. Aligns the second object, and any subsequently selected objects, with the 
horizontal center of the first selected object.

• Right. Aligns the second object, and any subsequently selected objects, with the right 
edge of the first selected object.

• Top. Aligns the second object, and any subsequently selected objects, with the top edge 
of the first selected object.

• Middle. Aligns the second object, and any subsequently selected objects, with the 
vertical middle of the first selected object.

• Bottom. Aligns the second object, and any subsequently selected objects, with the 
bottom edge of the first selected object.

A N C H O R E D  O B J E C T S
Anchors are used to specify the position of graph, legend, and text box objects as they 
expand. 
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For example, if additional text is added to a text box, the anchor points determine how the 
text box will adjust for the additional text. If you specify the Vertical Anchor as Bottom, 
and the Horizontal Anchor as Right, then as you add text to the text box, the bottom 
right of the text box will remain stationary, while the text box will expand left and upwards 
to accommodate the additional text.

To anchor  an  ob ject
1 Select the object you wish to anchor.

2 Using the Properties menu, select the object’s properties dialog.

3 Select the Advanced tab.

4 Change the anchor settings using the radio buttons.

You can anchor an object vertically to these three positions: Top, Middle, or Bottom. 
You can anchor an object horizontally to these three positions: Left, Center, or Right.

5 Select Apply or OK to save your settings.

I M A G E  F O R M A T

For best image quality, we recommend that you serve your PopChart images in the 
Macromedia® Flash™ or SVG™ formats. If you are serving your images in a different 
format, you should consider the following:

P D F  A N D  E P S   PDF and EPS images allow no interactivity. Drill-down 
effects, rollover data labels, transparency, and PopUp text will not be shown in 
these image formats.

P N G   Interactivity in PNG is supported via image-maps. Because of this, some 
older browsers may not support Drill-down effects, rollover data labels, and PopUp 
text. Also, feedback will be slow—it may take up to 2 seconds for rollover data 
labels or PopUp text to appear.

G I F   If you anticipate that your appearance file will be used mostly to generate 
GIF images, you should probably take into consideration that GIF images only 
support 256 colors. If you use a lot of colors or gradients in your graph, the image 
may not look as good as you want it to look when it is shown as a GIF image. Be 
sure to preview your appearance file to make sure that it looks okay as a GIF image.

Interactivity in GIF is supported via image-maps. Because of this, some older 
browsers may not support Drill-down effects, rollover data labels, and PopUp text. 
Also, feedback will be slow—it may take up to 2 seconds for rollover data labels or 
PopUp text to appear.

W B M P   If you anticipate that your appearance file will be used mostly for WBMP 
images, you will have to consider several factors as you create your appearance file. 
PopChart Builder User Guide 1-25
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For details, refer to “WBMP” on page 14-15 of the PopChart Server Reference 
manual.
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One very useful feature of PopChart Builder is the option to place multiple graphs in the 
same PopChart project. Each graph can have its own data, legend, and settings, as you can 
see in the PopChart image below.

For the most part, using multiple graphs in the same project is pretty straightforward. To 
place a second graph in your project, all you have to do is click on the Create a Graph 
button. To add a legend to this graph, simply select the graph and click on the Create a 
Legend button. You can customize the second graph just as you would customize any 
other graph.

If you are going to use your PopChart project as an appearance file for PopChart Server 
Pro, though, it is important that you be aware of each graph’s name. You will use the graph 
names when you change data or settings with the PCScript you send PopChart Server 
Pro. Thus, it is important that you know the names of the objects in your project, and that 
you don’t give objects the same name.

By default, PopChart Builder will try to give each object a unique name. Usually, the first 
graph object will be called graph, the next one called graph2, and so on. Text boxes and 
Legends have a similar naming scheme. You can see the name of an object by selecting that 
object and then looking at the status bar at the bottom of the PopChart Builder window. 
The name will be the last piece of information listed, right next to the word Name.

Occasionally, you may find it useful to rename the object. For instance, if your Pie graph is 
named graph22, you could rename it to pie for easier reference.

To Change the  Name of  a  Graph (or  Any Object )
1 Select the Object
PopChart Builder User Guide 1-27
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2 Select Properties > Graph Properties or right-click on the graph and select Graph 

Properties.

3 Go to the Advanced tab

4 Change the name listed in the box next to the words Object Name.

Important:  If you make a template from a project that has multiple graphs, and then try to create a new 
graph from the template using the PopChart Wizard, you will only be able to customize 
the settings for the first graph that was created in the project. You will have to customize 
everything else outside of the Wizard.

O V E R L A Y I N G  G R A P H S

One reason you might want to use multiple graphs is to layer one graph over another. This is 
useful when you want to compare two different data sets with different graph types and/or 
with different data ranges. For an example of how this might be useful, consider the 
following PopChart image.
PopChart Builder User Guide
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This image might be more interesting and useful if we overlaid the Line graph on top of the 
Stock graph so that we can make a visual comparison of the data more easily. The next 
PopChart image shows what this might look like.

Note that we had to make some modifications to the gridlines and scales to achieve this 
effect. Particularly, we removed bottom scale of the Stock graph so that the two bottom 
scales wouldn’t overlap with each other. Because of this, we also had to change the size of 
the Stock graph. Also note that we put the scale for the Line graph on the right side of the 
graph so that the two scales wouldn’t overlap. 

You will probably find the items on the Alignment menu of the PopChart Builder 
interface helpful in overlaying graphs, especially the Move to Front and Move to Back 
items.

Line graph, 
value scale on 
right side.

Stock graph

Legend for 
Stock graph

Legend for 
Line graph
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If you or your company create many graphs that are similar to each other, it may be 
beneficial to create a PopChart template. PopChart Builder users will be able to create 
appearance files from this template while using the PopChart Wizard. Since your 
template will already be customized to suit your or your company’s needs, the only thing 
you will have to do to create your final PopChart image after you select this template is 
enter in the new data. Obviously, this greatly simplifies the PopChart creation process.

To Create a  PopChart  Templa te
Creating a template is very easy.

1 Create a PopChart project that looks exactly like you want your template to look.

You may want to refer to “Tips for creating a PopChart Template” below for 
suggestions on how you should format your template.

2 Save your project.

3 Locate your appearance file.

4 Copy your project file to the PopChart Builder template directory.

This directory is the one specified in User Preferences > Template Directory. 
To keep things organized, you may want to create folders in the template directory for 
your new templates (e.g. Company Templates or Daily Stock Quotes). 

You may also want to change the name of the template file so it is something more 
appropriate (e.g. Stock Price 3D Bar.pcxml).

To Set  a  T i t le  Box  in  a  PopChar t  Templa te
One aspect of your template that you will want users to customize in the PopChart 
Wizard is the title box. Because the title box is just like any other text box, you will need to 
name it title so that the PopChart Wizard knows that it should put the title in that box.

1 Select the text box that contains the project title.

2 Right-click on the text-box.

3 Select Set as Title.

This will change the object name to title. If another text box was previously set as the 
title text box, it will be given a different name.
PopChart Builder User Guide
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• Make your project self-explanatory, so users know what they should modify and what 
they should leave alone. For example, if you have a text box where the user should enter 
today’s date, you should put the text Enter Today’s Date in the text box.

• Find out the image format and size that appearance files created from your template will 
need be set to. Set these in the template using Project Properties.

• It is difficult to anticipate what or how much data will be put into your template. A graph 
that looks good with a very small set of sample data may look horrible with twenty or 
thirty categories and series. Test your template with a variety of data to make sure that it 
still looks good.

• Avoid manually setting scales. Because you don’t know the data that will go into your 
graph, you may inadvertently clip some of the data.

• Decide how you want the graph to automatically adjust your bottom scale labels. This 
way, if it has to adjust labels, you have control over what it can and cannot do. For more 
information, refer to the section entitled “Scale Label Adjustments” on page 1-22.

• Again, because the data may vary, be careful when setting Drill-down URLs or PopUp 
Text. Only set these when you are absolutely certain that the data values you set these for 
will always use your drill-down or PopUp settings.

• If you want users to be able to change the title from within the wizard, make sure you 
name your title textbox title (refer to “Title Text Box” on page 1-19).

• All of the tips that apply to appearance files also apply to templates. For more 
information, refer to the section entitled “Tips for Creating Good Appearance Files” 
on page 1-18.
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DIALOG REFERENCE A

This appendix is a comprehensive list of all the dialogs and options you will see as you 
use PopChart Builder. It briefly describes the functionality of each option and then refers 
you to the main documentation for further explanation of that functionality. It is intended for 
reference only.

Note:  When a dialog or option applies only to certain graph types, a list of the graph types that it 
applies to will appear to the left of the heading for that dialog or option.

The following dialogs are discussed in this appendix:

• “PopChart Wizard”

• “User Preferences”

• “Project Properties”

• “Data Editor”

• “Graph Properties”

• “Gauge Properties”

• “Value Scale Properties”

• “Bottom Scale Properties”

• “Data Label Properties”

• “Series Properties”

• “Legend Properties”

• “Text Box Properties”

• “Image Properties”

• “Font Properties”

• “Color Properties”

• “Advanced Object Properties”
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The PopChart Wizard simplifies the process of creating your appearance file. It will guide 
you step by step through the process of selecting a graph type, entering graph data, 
customizing the project, and publishing it to the web.

Note:  Depending on your graph type or template selection, some of the options listed in this 
section may not be available.

B U T T O N S

Throughout the PopChart Wizard you will see the following buttons along the bottom of the 
Wizard.

B R O W S E R  P R E V I E W   This button launches your default web browser and 
shows you what your PopChart image will look like in it.

H E L P  This button launches context-sensitive help (in other words, this help 
window).

C A N C E L   This button cancels the PopChart Wizard. You will be taken to the 
PopChart Builder interface where you will see a blank appearance file.

B A C K   This button goes back one screen in the Wizard. Click on it if you need to 
go back and change a setting you made earlier.

Warning:  If you have made changes in one screen and then go back and make changes in a 
previous screen, you may lose your first changes.

N E X T   This button will go forward one screen in the Wizard. Click on it when 
you have finished with the current screen.

F I N I S H   This button will end the Wizard and take you to the PopChart Builder 
interface. Here you will be able to further customize the appearance file that you 
have created.

W I Z A R D  S T A R T U P

This screen allows you to choose the method by which you will create your appearance file. 
You can choose to build a project from a template or from the standard graph types. The 
screen explains what each option does.

S H O W  T H E  P O P C H A R T  W I Z A R D  O N  S T A R T U P   If you uncheck this, 
the next time you start PopChart Builder, you will skip the PopChart Wizard and 
PopChart Builder User Guide
www.corda.com



. .
 . 

. .D I A L O G  R E F E R E N C E

PopChart Wizard

User Guide�	
	�
go directly to a blank appearance file in the PopChart Builder interface. You can 
make PopChart Builder start with the PopChart Wizard again by checking the 
Start New Wizard on Startup box in your User Preferences.

S T A N D A R D  T Y P E S ( S C R E E N  1 )

This pane allows you to select a base graph type for your appearance file. To learn more 
about graph types, refer to Chapter 13, “Graph Types,” in the PopChart Server 
Reference manual.

S E L E C T  A  G R A P H  T Y P E   Allows you to choose from the standard graph 
types.

S U B T Y P E  Allows you to choose a subtype of your selected graph type.

T E M P L A T E S ( S C R E E N  1 )

This pane allows you to select a template from which to build your appearance file. 
Templates are pre-defined projects that are commonly used. You can select from the 
templates that come with PopChart Builder, or use one that you or your company has 
designed for you.

S E L E C T  A  T E M P L A T E   Navigate through this tree to find the template you 
are looking for. PopChart Builder will look for templates in the location specified 
in the Template Directory field of the User Preferences dialog (See Also: 
“Template Directory”). The first template you see will be the template that was 
selected the last time the PopChart Wizard was run.

P R E V I E W   This image is a preview of the currently highlighted template.

D A T A  S E L E C T I O N ( S C R E E N  2 )

This screen allows you to enter data for your graph. You can enter information either 
manually, or by pasting it from a spreadsheet program. To enter data manually, just select 
the first row and start typing. The Tab key cycles through the squares. To paste data, copy it 
from your spreadsheet program and use the Paste from clipboard and Clear All 
buttons to place it in the Wizard data table.

The Paste from Clipboard button will paste data into your table beginning with the top-
left most currently selected cell. The Clear button will delete the information in all 
PopChart Builder User Guide A-3
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currently selected cells. If you have selected only one cell, it will clear every cell in the 
table.

R O W  E N A B L E D   This option toggles the visibility of the currently selected 
row. If it is unchecked, this row will not be graphed. Otherwise, it will be graphed 
normally.

C O L U M N  E N A B L E D   This option toggles the visibility of the currently 
selected column. If it is unchecked, this column will not be graphed. Otherwise, it 
will be graphed normally.

S E R I E S  D A T A  I N  R O W S  /  C O L U M N S   This option allows you to 
transpose data by changing what information is considered to be Series data. By 
default, this option is set to Series Data in Rows, meaning that each row 
constitutes a series and each column constitutes a category. Choosing Series 
Data in Columns switches this around. The graph previews depicted above this 
option show you how the graph will look under each setting.

Graph 
Previews

Columns (Categories) 
of Data

Rows (Series) 
of Data

Series Label

Category Label

Paste data beginning 
with top-left currently 
selected cell

Clear data from 
currently selected cells 
(or all cells if only one 
cell is selected).

Data Value

Enables/Disables 
selected row/column.
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D A T A  F O R  P I E  I N  C O L U M N S  /  R O W S    This option appears for pie 
graphs instead of the previous option. It works as explained above.

G E N E R A L ( S C R E E N  3 )

This pane controls general settings for your appearance file. The image on the right shows 
you how the changes you make in this pane will affect your project.

E N A B L E  P R O J E C T  B O R D E R   Places a border around the entire project.

B O R D E R  C O L O R   Launches the Color Properties dialog, where you can 
change the project border color. For more information about this dialog, refer to 
“Color Properties” on page A-65.

B A C K G R O U N D  C O L O R   Launches the Color Properties dialog, where 
you can change the project background color. For more information about this 
dialog, refer to “Color Properties” on page A-65.

C O L O R  T H E M E   Changes the graph’s color theme. Color themes are pre-set 
color definitions that help determine the colors of bars, lines, wedges, and areas. 
You can create color themes adding them to the config/PCColors.xml file. Refer to 
“Color Themes” on page 11-1 of the PopChart Server User Guide.

This screen will be unavailable for gauges.

T I T L E ( S C R E E N  3 )

This pane helps you add a title box to your project. The image on the right shows you how 
the changes you make in this pane will affect your project.

G R A P H  T I T L E   If you enter text into this box, the Wizard will insert a title box 
into your project. You must press tab or enter for the text you type to be displayed.

T I T L E  P O S I T I O N   This option allows you to set the position of your title box. 
You can put it either above or below the graph. This option is not applicable for 
templates.

S H O W  B O R D E R   If checked, the title box will have a border around it.

S H O W  S H A D O W   If checked, the title box will have a shadow.

F O N T   This button will launch a Font Properties dialog, where you can 
change the title font.

This screen will be unavailable for gauges.
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A X E S ( S C R E E N  3 )

This pane allows you to add or remove axes from the graph. The image on the right shows 
you how the changes you make in this pane will affect your appearance file. This pane will 
not appear for templates or for pie graphs or gauges. 

B O T T O M  A X I S   If checked, scale labels and tick marks will appear along the 
bottom of the graph.

S I D E  A X I S   If checked, scale labels and tick marks will appear along the side of 
the graph. You can choose to put them on either the left or right of the graph.

This screen will be unavailable for gauges.

G R I D L I N E S ( S C R E E N  3 )

This pane allows you to add or remove gridlines. The image on the right shows you how the 
changes you make in this pane will affect your appearance file. This pane will not appear for 
templates or for pie graphs, pareto graphs, or gauges.

V E R T I C A L  L I N E S
These options enable or disable vertical gridlines.

Major Gridlines  If checked, major vertical gridlines will be displayed behind 
the graph.

Minor Gridlines  If checked, minor vertical gridlines will be displayed behind 
the graph. For some graph types, this option does nothing.

H O R I Z O N T A L  L I N E S
These options enable or disable horizontal gridlines.

Major Gridlines  If checked, major horizontal gridlines will be displayed 
behind the graph.

Minor Gridlines  If checked, minor horizontal gridlines will be displayed 
behind the graph. For some graph types, this option does nothing.

This screen will be unavailable for gauges.
PopChart Builder User Guide
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L E G E N D ( S C R E E N  3 )

This pane helps you add a legend to your appearance file. The image on the right shows you 
how the changes you make in this pane will affect your project. This pane will not appear 
for templates or for gauges.

S H O W  L E G E N D   If checked, PopChart Builder will place a legend in the 
project.

P O S I T I O N   This option allows you to set the position of the legend. You can 
place it to the right, left, bottom, or top of the graph.

This screen will be unavailable for gauges.

D A T A  L A B E L S ( S C R E E N  3 )

This pane helps you add data labels to your appearance file. The image on the right shows 
you how the changes you make in this pane will affect your project. This pane will not 
appear for templates or for gauges.

S H O W  D A T A  L A B E L S
If checked, data labels will appear when specified below:

Display Always  Data labels will always appear.

Display on Rol lover  Data labels will only appear when a user places his or 
her mouse over the relevant area.

P O S I T I O N
This option allows you to set the position of the data labels.

Outside Top  Data labels will appear immediately above the relevant area.

Inside Top  Data labels will appear immediately below the top edge of the 
relevant area.

Inside Bottom  Data labels will appear immediately above the bottom edge of 
the relevant area.

Outside Right  (Horizontal Bar graphs only) Data labels will appear 
immediately to the right of the right edge of each bar.

Inside Right  (Horizontal Bar graphs only) Data labels will appear immediately 
to the left of the right edge of each bar.
PopChart Builder User Guide A-7
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Inside Left   (Horizontal Bar graphs only) Data labels will appear immediately 
to the right the left edge of the each bar.

Out w/ Leader  (Pie graphs only) Data labels will appear outside of each pie 
wedge with leaders pointing from the wedges to their label.

Outside  (Pie graphs only) Data labels will appear outside of each pie wedge.

Inside  (Pie graphs only) Data labels will appear on the inside of each pie wedge.

D A T A  L A B E L  T E X T
This section allows you to change the data label format string. For information about this 
string, refer to “Custom Data Label Formatting” on page 1-12.

S H O W  B O R D E R
This option allows you to choose to display a border around your data label boxes. 

B O R D E R  C O L O R
You can choose a color for your border by clicking on the color button, which launches the 
Color Properties dialog, where you can change the data label border color. For more 
information about this dialog, see “Color Properties” on page A-65.

F O N T
This button will launch a Font Properties dialog, where you can change the data label 
text font and background color. For more information about this dialog, refer to “Font 
Properties” on page A-64.

This screen will be unavailable for gauges.

P O P U P  T E X T ( S C R E E N  3 )

This pane helps you customize the appearance of PopUp text in your appearance file. The 
image on the right shows you how the changes you make in this pane will affect your 
project. This pane will not appear for templates.

S H O W  B O R D E R   PopUp Text will appear with a single line border around it.

B O R D E R  C O L O R   Launches the Color Properties dialog, where you can 
change the PopUp text border color. For more information about this dialog, refer to 
“Color Properties” on page A-65.

F O N T   This button will launch a Font Properties dialog, where you can 
change the PopUp text font and background color. For more information about this 
dialog, refer to “Font Properties” on page A-64.
PopChart Builder User Guide
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This screen will be unavailable for gauges.
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The interface for PopChart Builder is similar to other applications. In this section, you will 
learn about the various components of your PopChart project, as well as PopChart Builder’ 
toolbar and menu options. The following figure displays an appearance file in PopChart 
Builder.

The large area in the background of the main screen is called the canvas. Everything you 
create in PopChart Builder is done on the canvas.

The rectangular area is called the project area. A project can have one or more graph objects 
inside of it. It can also have several text box and legend objects.

Graph objects consist of scales, a grid area, and graph items, such as a bars, lines, and pie 
wedges.

The status bar at the bottom of the canvas identifies the location of your mouse pointer on 
the screen and the name of the currently selected object in the project.

In addition to understanding the components on the canvas, it is helpful to become familiar 
with the following: toolbar buttons, menu options, keyboard shortcuts.

Menu Bar

Toolbar

Canvas

Project

Status Bar

Graph
PopChart Builder User Guide
www.corda.com



. .
 . 

. .D I A L O G  R E F E R E N C E

PopChart Builder Interface

User Guide�	
	�
T O O L B A R  B U T T O N S

The toolbar provides quick access to the key functions you perform. Below is a table 
describing all of the toolbar buttons in PopChart Builder.

M E N U S

The following table lists all of the PopChart Builder menu items.

Button Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
New Project

Open project

Save project

Preview project in browser

Create a graph

Create a legend

Create a text box

Create an Image

Delete selected object

Delete selected part of graph

Undo last action

Redo last undo

Show Help

Select generic graph type

Select graph sub-type 
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F I L E  M E N U

E D I T  M E N U

Menu Item Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
New Creates a new appearance file from a blank canvas. Automatically closes the 

current document.

New Wizard Creates a new appearance file using the PopChart Wizard. Automatically 
closes the current document.

Open Opens an existing appearance file. Automatically closes the current 
document.

Recent Projects Lists the latest (user specified) number of projects accessed in PopChart 
Builder. Selecting one of these projects will close the currently opened 
appearance file.

Save Saves the current appearance file.

Save As Saves the current appearance file under a different name.

Preview Opens up the user’s default browser and shows how the appearance file will 
look as a dynamically generated PopChart image.

Sample Code Opens the Sample Code dialog. This dialog will help you generate code to 
embed your appearance file into a web page.

PopChart License Prompts the user for the PopChart Builder license key.

Exit Exits the Program.

Menu Item Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Undo Undo the last command

Redo Redo the last undo command

Create Graph Creates a new graph in the project.

Create Legend Creates a legend for the selected graph. You can only have one legend per 
graph.

Create Text box Creates a text box in the project.

Duplicate Object Duplicates the selected object

Delete Object Deletes the selected object

Next Object Selects the next object

Previous Object Selects the previous object

Preferences Opens User Preferences dialog. User preferences include: default 
configuration for the PopChart Wizard, location for template files, and 
location for saved projects.
PopChart Builder User Guide
www.corda.com



. .
 . 

. .D I A L O G  R E F E R E N C E

PopChart Builder Interface

User Guide�	
	�
P R O P E R T I E S  M E N U
The properties menu changes based on the items selected. The following identifies the 
available property menus:

A L I G N M E N T  M E N U
Changes the alignment of the currently selected object. For more information on aligning 
objects, refer to “Aligned Objects” on page 1-24.

Menu Item Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Data Editor Opens the Data Editor dialog where you can change the graph data and the 

display configurations, and determine if the graph will reflect the data in 
rows or columns.

Graph Properties Opens the Graph Properties dialog where you can change the following: 
general settings, data labels, gridlines, drill-down configuration, popup text 
configuration, 3D settings, colors, and position.

Left or Right 
Scale Properties

Opens the Scale Properties dialog. Scale properties include the 
following: scale position, tick marks, label configuration, font, and position.

Bottom Scale 
Properties

Opens the Bottom Scale Properties dialog. Bottom scale properties 
include the following: tick marks, label configuration, and font.

Data Label 
Properties

Opens the Data Label Properties dialog where you can change the way 
data labels are displayed for the currently selected graph.

Series Properties Opens the Series Properties dialog where you can change the following: 
general settings, popup text, drill-down data.

Gauge Properties Opens the Gauge Properties dialog where you can change the data value 
and label, color ranges, and formatting options.

Text Box 
Properties

Opens the Text Box Properties dialog where you can change the 
following: general formatting, font, borders and shadows, and display 
position.

Legend Properties Opens the Legend Properties dialog where you can change the font, 
borders, shadows, and legend display position.

Project Properties Opens the Project Properties dialog where you can change the following: 
image format, background color, gradient shading, border style, numeric 
settings, and advanced settings.

Image Properties Opens the Image Properties dialog where you can change dimensions, 
transparency, drill-down, and PopUp settings for an imported image.
PopChart Builder User Guide A-13
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H E L P  M E N U

K E Y B O A R D  S H O R T C U T S
The following table lists the various keyboard shortcuts available in PopChart Builder.

Menu Item Functionality. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Quick Start Guide Opens the Quick Start Guide which will display the PopChart Quick 

Start manual.

View Documentation Opens the online help system

Visit PopChart.com Opens the default browser to the PopChart Builder home page.

Click for Updates Opens the default browser and checks Corda Technologies website for 
updates.

Corda Technical 
Support

Opens the default browser to the Corda Technologies technical support 
page.

Register PopChart 
Builder

Opens the default browser to 
http://www.corda.com/register/registration. If your license key has 
been entered during installation or through File > PopChart License, 
your key number will automatically be entered when you go to this page, 
so you don’t have to type it in. 

Purchase PopChart 
Products

Opens the default browser to the online Corda Technologies online 
shopping mall, where you can buy PopChart products.

About PopChart Provides version information and copyright details for Corda 
Technologies, Inc. and PopChart Builder.

Keystroke Shortcut To. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Alt-F4 Exit

Ctrl-D Preview in browser

Ctrl-G Create graph

Ctrl-L Create legend

Ctrl-N New

Ctrl-O Open project

Ctrl-Q Quit (Exit) 

Ctrl-T Create Text Box

Ctrl-S Save

Ctrl-Z Undo

Ctrl-Shift-N New Wizard

Ctrl-Shift-S Save As

Ctrl-Shift-Z Redo

F1 View Documentation
PopChart Builder User Guide
www.corda.com
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F10 File Menu

Shift-Tab Select Previous Object

Tab Select Next Object

Keystroke Shortcut To. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
PopChart Builder User Guide A-15
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These settings affect how PopChart Builder will run in general. They can be accessed by 
selecting Edit > Preferences from the PopChart Builder interface. If you change one of 
these settings, the change will affect PopChart Builder every time you use it, not just how 
it behaves for the current appearance file.

G E N E R A L

The settings on this page affect how PopChart Builder behaves in general.

S T A R T  N E W  W I Z A R D  O N  S T A R T U P
If checked, PopChart Builder will begin with the PopChart Wizard. Otherwise, it will 
begin with an empty project.

R E M E M B E R  M A I N  W I N D O W  S I Z E / P O S I T I O N
If checked, PopChart Builder will restart at the same location and with the same size on 
your screen as when you last exited the program. Otherwise, it will restart in its default 
location with the default size.

R E M E M B E R  D I A L O G  P O S I T I O N S
If checked, PopChart Builder will place new dialogs in the same location as when they 
were last closed. This means if you move a dialog once, you will not have to do it again.

D E F A U L T  W I Z A R D  T Y P E
This determines whether the PopChart Wizard will start with templates (choose 
Templates, which is selected by default) or with the standard graph types (choose 
Standard Types).

P R E V I E W  O P T I O N S
These options allow you to control how PopChart Builder will show your PopChart 
images when you click on the browser preview button.

Image Format  Allows you to change the default format of your PopChart 
images. The available settings are:

• Flash

• SVG

• GIF

Create  d Descript ive  Text   If checked, this box tells PopChart Builder to 
generate descriptive text for the visually impaired with each new project.
PopChart Builder User Guide
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R E C E N T  P R O J E C T S
The number of projects that PopChart Builder will remember in the Files > Recent 
Projects menu item.

T E M P L A T E  D I R E C T O R Y
This is the location for all templates. PopChart Builder will look at this location when 
showing you the available templates. By default, it is set to the lib/Templates folder inside 
of the PopChart Builder root directory.

S A V E  O P T I O N S

The settings in this dialog pane affect how PopChart Builder saves your appearance file.

A P P E A R A N C E  P R O P E R T I E S
These settings control how PopChart Builder will generate your appearance file’s 
PopChart XML.

Verbose  PopChart Builder will output all attributes and elements, regardless of 
whether or not they are using the default value. Not only does this setting produce a 
large appearance file, but it takes PopChart Server up to 4 times longer to process 
this appearance file. This option is provided mostly to help you learn more about 
PopChart XML.

Minimal   PopChart Builder will remove any attributes or elements that are set 
to their default value, making your appearance file as small as possible. This is the 
default setting.

D A T A  F O R M A T T I N G
This controls how PopChart Builder saves the data in your appearance file. The only 
reason you would want to change this setting is to learn how your PopChart XML should 
look if you need to import data in PopChart XML using a row/column spreadsheet format 
instead of the default series/categories/data format.

Native  PopChart Builder exports the data as it normally would, using Series, 
Category, and Data tags. This is the default setting.

Row/Column  PopChart Builder exports the data in spreadsheet form, using 
Row and Cell tags.

S H O W  P C X M L  E R R O R S  I N  B U I L D E R
This controls whether or not PopChart Builder will notify you of errors in PCXML 
documents that it opens. By default, this is turned off. This functionality is provided to help 
you check the validity of your PCXML documents.
PopChart Builder User Guide A-17
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S A V E  U S I N G  L A T E S T  P C X M L  F O R M A T
Allows you to specify the version of PCXML to use for saving appearance files. If this is 
not selected, your appearance files will be saved in the 4.0 format. If it is selected, they will 
be saved in the 4.0.5 format.

Many elements and attributes have been added or renamed since the 4.0 version of PCXML. 
You cannot use appearance files in the current PCXML version with previous versions of 
PopChart Builder. However, the current version of PopChart Builder supports previous 
versions of PCXML.

To maintain backwards compatibility, PopChart Builder saves appearance files in the 
PCXML 4.0 format by default. If you are using PopChart Server 4.0.5, you can take 
advantage of new PCXML features by checking this box.

D E F A U L T  S A V E  L O C A T I O N
This is the default location for all saved files. By default, this is set to the 
chart_root/apfiles folder inside of the PopChart root directory.

D I A L O G  F O N T

This dialog pane allows you to change the system font used by PopChart Builder. If you 
are unable to see international or double-byte characters when you type them in your text 
boxes, you can resolve that problem by choosing a font that supports your international or 
double-byte characters. To change the font, select it by double-clicking or pressing Select. 
The click OK.

You can change the font back to the default font by clicking the Use Default button.
PopChart Builder User Guide
www.corda.com



. .
 . 

. .D I A L O G  R E F E R E N C E

Project Properties

User Guide�	
	�
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . P R O J E C T  P R O P E R T I E S

This dialog allows you to set global properties for the project, such as the output image type 
and size of the project background and border colors. This dialog can be accessed by 
selecting Properties > Project Properties.

G E N E R A L

Allows you to change general settings for the appearance file.

B A C K G R O U N D  C O L O R
Sets the background color for the appearance file.

G R A D I E N T  B A C K G R O U N D
Enables and controls the format of the gradient background.

None  Uses the Background Color setting only. The background will be solid.

Top to Bottom  Makes the background a gradient starting with the 
Background Color at the top edge of the project and ending with the End 
Color at the bottom edge of the project.

Left  to  Right   Makes the background a gradient starting with the 
Background Color at the left edge of the project and ending with the End 
Color at the right edge of the project.

End Color  Specifies ending color for the gradient.

S I Z E  I N  D E S I G N E R
Sets the size of appearance file in your designer workspace. 

This setting only affects how big the project will appear on your screen. It will not scale the 
graph, text box, or legend objects that are in the project. If you change this setting, you will 
probably need to resize these objects, also.

Width  Specifies the width in pixels of the appearance file.

Height  Specifies the height in pixels of the appearance file.

B O R D E R

Controls the appearance file border settings.
PopChart Builder User Guide A-19
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B O R D E R  T Y P E
Sets the project border type. Available options include:

• None

• Thin

• Regular

• Thick

• Double Thin

• Double - Thin Inside, Thick Outside

• Double - Thick Inside, Thin Outside

C O L O R
Sets the project border color.

N U M E R I C  S E T T I N G S

Controls the way numbers will be displayed within the project, including abbreviations for 
large numbers and currency symbols. These settings will affect all objects in the appearance 
file.

C U R R E N C Y  S Y M B O L
Specifies the symbol that should be used to display any scale label numbers that represent 
currency (e.g. $ or USD). 

Note:  In order for a number to actually appear as currency you must specify that it be displayed as 
currency in the Value Scale Properties > Label dialog pane.

Symbol on Left   Places the currency symbol on the left side of the number.

Symbol on Right  Places the currency symbol on the right side of the number.

D E C I M A L
Specifies the symbol that should be used as the decimal indicator. You can choose either a 
period (3.14), comma (3,14), or blank space (3 14).

T H O U S A N D S
Specifies the symbol that should be used as the thousands indicator. You can choose either a 
comma (1,000,000), period (1.000.000), or blank space (1 000 000).
PopChart Builder User Guide
www.corda.com



. .
 . 

. .D I A L O G  R E F E R E N C E

Project Properties

User Guide�	
	�
A B B R E V I A T I O N  C H A R A C T E R S
Specifies the characters that will be used to abbreviate numbers in the project. For example, 
if Thousands is set to K and you have chosen to display the value as thousands, $15,000 
would be displayed as $15K.

Note:  In order for a number to actually appear abbreviated you must specify that it be shown with 
the abbreviation in the Value Scale Properties > Label dialog pane. Only scale labels 
can be shown with an abbreviation.

Thousands  Specifies abbreviation for numbers that are displayed as thousands.

Mill ions  Specifies abbreviation for numbers that are displayed as millions.

Bil l ions  Specifies abbreviation for numbers that are displayed as billions.

Tril l ions  Specifies abbreviation for numbers that are displayed as trillions.

A D V A N C E D

Controls advanced settings for the appearance file.

A D J U S T  G R A P H  S I Z E  T O  P R E V E N T  O V E R L A P
If checked, this setting automatically resizes graph objects so that they do not overlap with 
other objects. This setting is useful when dealing with dynamic data, as the legend and 
graph objects can grow to unanticipated sizes.

A U T O  R E S I Z E  T O  F I T  H E I G H T  A N D  WI D T H
If checked, this setting automatically resizes the PopChart image to the size specified in the 
request to PopChart Server. This applies only when the height and width PopChart 
Embedder attributes or the @_HEIGHT and @_WIDTH server commands have been used.

K E E P  C O M P O N E N T S  W I T H I N  H E I G H T  A N D  W I D T H
If checked, this setting forces the appearance file to format itself so that all of its objects 
remain inside of its border. This setting is useful when dealing with dynamic data, as the 
legend and graph objects can grow to unanticipated sizes.
PopChart Builder User Guide A-21
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This dialog allows you to manipulate the data inside of the currently selected graph object. 
It can be accessed by selecting a graph, and then selecting Properties > Data Editor.

You can enter information manually, or you can paste it from a spreadsheet program. To 
enter data manually, just select the first row and start typing. The Tab key cycles through 
the cells. To paste data, copy it from your spreadsheet program and use the Clear and 
Paste buttons to place it in the PopChart Builder data window.

The Paste button will paste data into your table beginning with the top-left most currently 
selected cell. The Clear button will delete the information in all currently selected cells. If 
you have selected only one cell, it will clear every cell in the table.

S E R I E S  D A T A  I N  R O W S  /  C O L U M N S   This option allows you to 
transpose data by changing what information is considered to be Series data. By 
default, this option is set to Series Data in Rows, meaning that each row 

Graph 
Previews

Columns (Categories) 
of Data

Rows (Series) 
of Data

Series Label

Category Label

Paste data beginning with 
top-left currently selected cell

Clear data from 
currently selected cells

Data Value

Sets which column (category) of data is used for the 
pie graph legend and data (Pie graphs only).

Enables/Disables 
selected row/column.
PopChart Builder User Guide
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constitutes a series and each column constitutes a category. Choosing Series 
Data in Columns switches this around. The graph previews depicted above this 
option show you how the graph will look under each setting.

D A T A  F O R  P I E  I N  C O L U M N S  /  R O W S    This option appears for pie 
graphs instead of the previous option. It works as explained above.

R O W  E N A B L E D   This option toggles the visibility of the currently selected 
row. If it is unchecked, this row will not be graphed. Otherwise, it will be graphed 
normally.

C O L U M N  E N A B L E D   This option toggles the visibility of the currently 
selected column. If it is unchecked, this column will not be graphed. Otherwise, it 
will be graphed normally.

S E R I E S  E N A B L E D   This option toggles the visibility of the currently selected 
series. If it is unchecked, this series will not be graphed. Otherwise, it will be 
graphed normally.

C O L U M N  /  R O W  F O R  P I E  L E G E N D   Sets which column (category) of 
data contains the legend and series label information in a pie graph. This option is 
only available for Pie graphs.

C O L U M N  /  R O W  F O R  P I E  D A T A   Sets which column (category) of data 
contains the data information in a pie graph. This option is only available for Pie 
graphs.
PopChart Builder User Guide A-23
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This dialog allows you to change settings directly related to the currently selected graph. It 
is accessed by selecting a graph and then selecting Properties > Graph Properties. 
Depending on the graph type, some or all of the following options may be available. Where 
appropriate, the graphs that these options affect are listed to the right of the option header.

For more information about Graph Types, refer to Chapter 13, “Graph Types,” in the 
PopChart Server Reference manual.

G E N E R A L

This pane controls general graph formatting and display options.

G R A P H  F O R M A T T I N G ( A L L  G R A P H S )
This controls how the graph object is formatted in regards to tick marks and labels.

Keep Text  and Ticks  Within Graph Bounds  This setting keeps scale 
labels and tick marks within the graph object’s boundaries. As the text in scale 
labels grows, the graph’s grid area will shrink to compensate.

Allow Text and Ticks  Outside of  Bounds  This setting moves the scale 
labels and tick marks outside of the graph object’s boundaries. This means that the 
graph’s grid area will always be the same size, regardless of the scale label text. 
This setting makes it easier to overlap graphs, since it guarantees that same-sized 
graph objects will have grid areas of the same size.

O U T L I N E  T Y P E ( B A R ,  L I N E  B A R )
This allows you to apply an outline to your bars. By default, there will be no outline 
(None). The other options are Lighter and Darker and Color.

Color  Launches the Color Properties dialog, where you can change the 
PopUp text border color. For more information about this dialog, refer to “Color 
Properties” on page A-65.

S I N G L E  S E R I E S  M U L T I C O L O R  M O D E (BAR)
In the event that there is only one series of data, checking this will make the graph display 
each item in the series in a different color instead of in the same color. Otherwise this will 
have no effect. This setting does not apply to Stacked Bar graphs.

S P A C E  B E T W E E N  B A R S ( B A R ,  L I N E  B A R ,  P A R E T O )
Specifies the amount of white space between each bar in a Bar graph as a percentage of the 
Bar Width. You can choose from three default settings, or specify another setting by 
selecting Other and manually entering the percentage of white space.
PopChart Builder User Guide
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B A R  W I D T H ( B A R ,  L I N E  B A R ,  P A R E T O )
Specifies the width of the bars in a Bar graph as a percentage of the category width. You can 
choose from three default settings, or specify another setting by selecting Other and 
manually entering the percentage of white space. This setting does not apply to Stacked Bar 
graphs.

M A N U A L L Y  S E T  N U M B E R  O F  L I N E S ( L I N E  B A R )
By default, the series of data in a Line Bar Combo graph are divided evenly into lines and 
bars. Checking this setting allows you to specify the number of series that should be 
represented as lines. For example, if you check this box and type in 3 as the Number of 
Lines, the first three series of data will be shown as lines, while all of the other series will 
be shown as bars.

F L O A T I N G  B A R S ( S T A C K E D  B A R )
Renders the last series, which is represented by the bottom segment of a Stacked Bar graph, 
invisible. This makes the bar appear to be floating.

S H O W  G R A P H  L A B E L (PIE)
When this is checked, a label will appear above the Pie graph. This label corresponds with 
the category label for the category that is being graphed.

G R A P H  S T Y L E (PIE)
This option allows you to choose from three different ways of displaying a Pie graph: 2D, 
2D with Gaps, and 3D. The picture above each setting will give you an idea of the effect.

S O R T  D A T A ( X - Y  P L O T ,  T I M E  P L O T )
Tells the X-Y Plot graph to draw a line connecting plot points according to the order of their 
x values as opposed to the order in which they appear on the spreadsheet.

Warning:  Do not use PopUp text when you select this option. PopUp text will not work 
correctly.

B U B B L E  S I Z E (BUBBLE)
Allows you to scale the size of the bubbles in your graph. This can be useful if you have 
extremely large or small bubble values.

V A L U E  R E P R E S E N T E D  B Y (BUBBLE)
Changes how PopChart Builder uses the bubble value to determine the size of the bubble. 
If set to Width of Bubbles, PopChart Builder will use your bubble value as the diameter 
of the bubbles. If set to Area of Bubbles, PopChart Builder will use your bubble value 
as the area of the bubbles.
PopChart Builder User Guide A-25
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S H O W  W E E K L Y  G R I D S  O N ( T I M E  P L O T )
Selects the day of the week on which minor gridlines should occur. This can be especially 
useful if you need your gridlines to correspond to Monday for the start of the business week 
instead of Sunday.

This setting only affects graphs where the range of the time scale is such that the minor 
gridlines fall on each week. For graphs with a larger time scale (generally, any range larger 
than six months, with dates occuring over more than one calender year), or a smaller time 
scale (generally, a range smaller than two months) this setting has no effect.

D A T E  I N P U T  F O R M A T ( T I M E  P L O T )
This box allows you to change the data input format string.

This string determines how PopChart Builder and PopChart Server translate your data 
values to actual time values. It uses macros to indicate different values, such as month, day, 
or minute. You can also enter static text if your time values contain slashes or colons

For example, the default format is %m/%d/%Y. this means that when you enter data into 
the Data Editor, or when you send to PopChart Server dynamically, you should enter the 
month, followed by a slash, followed by the day, followed by a slash, followed by the four 
digit year (e.g. 12/31/2001).

As another example, suppose all of the time values you are graphing occur on the same day, 
and you just want to enter the hour and minutes (e.g. 9:30, 10:00, 14:15, etc). To do this, 
you would choose %H:%M as your date input format.

The table below this box on the dialog screen indicates what time macros PopChart 
Builder accepts. A list is also available on page 5-17 of the PopChart Server Reference 
manual.

S E R I E S  T R A N S P A R E N C Y (RADAR)
Sets the transparency of the area fill for a radar graph. Radar graphs use transparency so that 
you can see data items below the top data item.

G R I D L I N E S ( A L L  E X C E P T  P I E ,  P A R E T O ,  G A U G E S )

This pane controls settings for the gridlines behind the currently selected graph object. On 
the left you will find a series of check boxes. Each box, when checked, enables the gridline 
indicated by the name to the right of the box. The image on the right side of the pane shows 
you which gridlines correspond to what name. To the left of each check box is a color 
button. Clicking on these buttons will bring up the Color Properties dialog (refer to 
“Color Properties” on page A-65), from which you can select a different color for the 
corresponding gridline.
PopChart Builder User Guide
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D R I L L - D O W N

This pane controls options for drill-down effects in the currently selected graph. For 
information about Drill-down effects, refer to “Drill-down Effects” on page 7-14 of the 
PopChart Server User Guide.

D R I L L - D O W N  U R L
This sets a global drill-down destination for the data items in your graph. This is the URL 
(internet address) of the web page or resource to which the user will be forwarded when he 
or she clicks on a data item. You can also use JavaScript instead of a URL. This string can 
contain any macros listed in the Value Keywords box below.

If set, all data items will drill-down to this destination unless you specify otherwise in the 
Series Properties > Drill-down URLs dialog pane, or dynamically with the 
graph.DDEnable() method.

For information about the global drill-down effects and macros, refer to “Global Drill-down 
Settings and Macros” on page 1-14.

V A L U E  K E Y W O R D S
This is a list of macros that can be used in the drill-down metastring. You can insert any of 
these macros into the drill-down URL box above by selecting the appropriate macro and 
clicking on the Insert button. A complete list of these macros is available in Table 1.2 on 
page 1-15.

M E T H O D  F O R  H I G H L I G H T I N G  N O N - T E X T  I T E M S
This option changes the method for highlighting non-text items, such as bars or pie wedges, 
that have been enabled for drill-down effects. You can choose from the following options:

OutLine  A single line outlines the drill-down area as the mouse passes over it.

Bold OutLine  A double line outlines the drill-down area as the mouse passes 
over it.

Color Change  The drill-down area changes color as the mouse passes over it. 
It will change to a lighter shade of its current color. Note that this means the user 
will be unable to see the color change on white objects. This only applies to certain 
graphs.

C O L O R  F O R  T E X T  H I G H L I G H T I N G
When drill-down is enabled for a text item, the color of the text item will change to the color 
shown in the color button. To change this color, click on the button. This will bring up the 
will bring up the Color Properties dialog (refer to “Color Properties” on page A-65), 
from which you can select a color.
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P O P U P

This pane controls the format of PopUp text in the currently selected graph. PopUp text will 
appear as a user rolls his or her mouse over a data item. For more information about PopUp 
text, refer to “PopUp Text” on page 7-12 of the PopChart Server User Guide.

Note:  These settings do not change the way popup is displayed for GIF images.

J U S T I F I C A T I O N
Changes the justification of the PopUp text. Settings include: left, center, and right. The 
effects of this setting will only be seen when there are multiple lines of PopUp text.

M A R G I N  V A L U E S
These values set the margin between the actual PopUp text and the edge of the PopUp text 
box.

Top  Sets the space in pixels between the top of the text and the top edge of the 
text box.

Left  Sets the space in pixels between the left edge of the text and the left edge of 
the text box.

Bottom  Sets the space in pixels between the bottom of the text and the bottom 
edge of the text box.

Right  Sets the space in pixels between the right edge of the text and the right 
edge of the text box.

S E T  W O R D  WR A P P I N G  WI D T H  T O
If checked, this box specifies that the PopUp text box should be no wider than the number of 
pixels indicated in the box below. If the PopUp text is wider than this value, it will 
automatically wrap and form another line inside of the PopUp text box.

S H O W  B O R D E R
If checked, the PopUp text box will be surrounded by a border.

Border Color  Allows you to change the color of the PopUp text box. Clicking 
on it brings up the Color Properties dialog (refer to “Color Properties” on 
page A-65).

F O N T
This button will launch a Font Properties dialog, where you can change the font of the 
PopUp text for the graph. For more information about this dialog, refer to “Font 
Properties” on page A-64.
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N O T E S

This pane controls the format of dynamically created (not static) PopChart Notes in the 
currently selected graph. For more information, refer to the section entitled “PopChart 
Notes” on page 1-15.

L A Y O U T  N O T E S
This sets how PopChart Server will try to lay out your dynamically created PopChart 
Notes. The available options include: Default, Outside First, and Inside First.

J U S T I F I C A T I O N
Changes the justification of the text in the Note. Settings include: left, center, and right. 
The effects of this setting will only be seen when there are multiple lines of Notes.

M A R G I N  V A L U E S
These values set the margin between the actual Note text and the edge of the Note box.

Top  Sets the space in pixels between the top of the text and the top edge of the 
text box.

Left  Sets the space in pixels between the left edge of the text and the left edge of 
the text box.

Bottom  Sets the space in pixels between the bottom of the text and the bottom 
edge of the text box.

Right  Sets the space in pixels between the right edge of the text and the right 
edge of the text box.

S E T  W O R D  WR A P P I N G  WI D T H  T O
If checked, this box specifies that the Note box should be no wider than the number of 
pixels indicated in the box below. If the Note box is wider than this value, it will 
automatically wrap and form another line inside of the Note box.

S H O W  B O R D E R
If checked, the PopUp text box will be surrounded by a border.

Border Color  Allows you to change the color of the PopUp text box. Clicking 
on it brings up the Color Properties dialog (refer to “Color Properties” on 
page A-65).
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F O N T
This button will launch a Font Properties dialog, where you can change the font of the 
PopUp text for the graph. For more information about this dialog, refer to “Font 
Properties” on page A-64.

L E A D E R  L I N E  W I D T H
The width of the leader line. The leader line is the line that originates from the data item and 
leads to the Note box.

L E A D E R  C O L O R
This color button allows you to set the color of the leader line. Clicking on it brings up the 
Color Properties dialog (refer to “Color Properties” on page A-65).

M O N T H / D A Y  N A M E S ( T I M E  P L O T )

This dialog allows you to change the names used for months and weekdays within a graph. 
For example, if you want your month and day names to be abbreviated, you could 
abbreviate them all in this dialog pane. Also, you could change these names to another 
language.

3 D  S E T T I N G S ( A R E A ,  B A R ,  L I N E ,  P A R E T O ,  P I E )

This pane controls 3D settings for the currently selected graph. 

S H O W  3 D  G R A P H ( L I N E  B A R )
This option is available only for Line Bar graphs. If checked, the graph will appear as a 
three-dimensional graph. Otherwise, it will be two-dimensional. Note that this option will 
always make the bars three dimensional. However, Show 3D Line must be checked for 
the line to appear three dimensional.

S H O W  3 D  B A R S  /  L I N E S  /  P I E  /  A R E A
If checked, the indicated feature (bar, line, pie, or area) will appear 3D, as will the 
background grid. However, this will have no affect on a Line Bar graph unless Show 3D 
Graph is enabled.

X  O F F S E T  %
Changes the offset, as a percentage of the category width, of the x dimension of the bar, 
area, or line. The offset affects the angle from which the user appears to be looking at the 
graph. Values can range from 0 to 40. This setting does not apply to Pie graphs.
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Y  O F F S E T  %
Changes the offset, as a percentage of the category width, of the y dimension of the bar, pie, 
area, or line. The offset affects the angle from which the user appears to be looking at the 
graph. Values can range from 0 to 40.

D E P T H  %
Changes the depth, as a percentage of the category width, of the bar, line, area, or pie. This 
is essentially the z dimension of the graph.

C O L O R S

This pane controls color settings for the currently selected graph.

S E R I E S  C O L O R S
This allows you to change the color settings for the data series.

Select  a  Color Theme  Allows you to select from several pre-set color 
themes. Selecting a new color theme will override any color changes that you have 
already made for bars, lines, areas, or pie wedges. It will not affect background, 
border, or font colors.

Color themes are set in the config/PCColors.xml file. Refer to Chapter 11, “Color 
Themes,” in the PopChart Server Reference manual for details on how to add 
color themes to this file.

Colors  These 16 color buttons represent the colors of the bars, lines, pie wedges, 
or areas within the graph. The first color corresponds to the first data series, the 
second to the second series, and so on. You can set colors for up to 16 data series 
before the graph will start reusing colors. You can change each color with the 
Color Properties dialog that comes up when you click on a color button (refer to 
“Color Properties” on page A-65).

To set colors for series beyond the first 16 series, change the color button for that 
series in the Series Properties dialog. 

G R I D  A R E A  B A C K G R O U N D  C O L O R S
This allows you to change the background color of the graph’s grid area. 

By default, the transparent box is checked, meaning that the area will have no background 
color. If you uncheck this box, the area will have the background color shown in the color 
button to the right of the check box. You can change this color with the Color Properties 
dialog that comes up when you click on a color button (refer to “Color Properties” on 
page A-65). The image on the far right indicates the areas that each option changes. Note 
that Side and Bottom affect only 3D graphs.
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A D V A N C E D

This controls advanced properties for the graph object. For more information, refer to the 
section entitled “Advanced Object Properties” on page A-66.
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This dialog allows you to set the formatting of and data within your Gauge. For more 
information about Gauges, refer to “Gauges” on page 13-35 of the PopChart Server 
Reference manual.

G E N E R A L

In this dialog pane, you can set the data value and color ranges for your Gauge. For more 
information about Gauges, refer to “Gauges” on page 13-35 of the PopChart Server 
Reference manual.

V A L U E
This sets the value of the Gauge.

M I N I M U M
This sets the minimum value of the Gauge. It is used when calculating the data value as a 
percentage. It also sets the extreme right value of the bar in a bar gauge. It does not affect 
any formatting in a Bulb gauges.

M A X I M U M
This sets the maximum value of the Gauge. It is used when calculating the data value as a 
percentage. It also sets the extreme left value of the bar in a bar gauge. It does not apply to 
Bulb gauges.

B A C K G R O U N D  C O L O R
This allows you to change the background color of the Gauge.

S H O W  B O R D E R
This allows you to toggle the 3D border of the Gauge.

S H O W  V A L U E  A S  P E R C E N T A G E
If this is checked the Gauge’s value will be shown as a percentage of the difference between 
the minimum and maximum values.

S H O W  C O L O R  R A N G E
If this is checked, small color bars along the top and bottom scales of the gauge, indicating 
the Gauge’s color ranges. (LED Bar and Filled Bar only)

C O L O R  R A N G E S
This box displays the color ranges currently being used in the graph. It shows the name of 
the range, the minimum and maximum value of the range, and the color of the range.
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A D D  R O W
When you click on this button, you will bring up a dialog that allows you to add a new color 
range to the Gauge. you will be able to select the name of the color range (which can be 
completely arbitrary), the minimum and maximum values of the range, and the color of the 
range.

D E L E T E  R O W
This will delete the currently selected color range from the Gauge.

S C A L E

This dialog pane allows you to change scale properties for Gauges.

S H O W  S C A L E ( B A R  G A U G E S  O N L Y )
This allows you to toggle whether or not the scale will be drawn (Bar Gauges Only).

C O L O R ( B A R  G A U G E S  O N L Y )
This allows you to change the color of the scale.

B A C K G R O U N D  C O L O R ( B A R  G A U G E S  O N L Y )
This allows you to change the background color of the bar and scale (i.e. the color that will 
be drawn when there is no color range).

S I Z E  M A N U A L L Y
This allows you to manually set the maximum size of the bar or bulb in pixels.

S H O W  M A J O R  T I C K S ( B A R  G A U G E S  O N L Y )
This allows you to turn major tick marks on or off.

Number  Sets the number of major tick marks.

Color  Sets the color of the tick marks. Clicking on this button brings up the 
Color Properties dialog (refer to “Color Properties” on page A-65).

S H O W  M I N O R  T I C K S ( B A R  G A U G E S  O N L Y )
This allows you to turn minor tick marks on or off.

Number  Sets the number of minor tick marks.

Color  Sets the color of the tick marks. Clicking on this button brings up the 
Color Properties dialog (refer to “Color Properties” on page A-65).
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L A B E L S

This dialog pane allows you to change the gauge label (appears to the left or on the top) and 
value label (appears to the right or on the bottom) of your Gauge.

S H O W  G A U G E  L A B E L
This allows you to turn the Gauge label on or off.

Posi tion   Sets the alignment of the gauge label. the available options include: 
Center, Left, Right, Top, and Bottom (options will depend on value of Show 
Labels On).

Text  Sets the gauge label text. Be careful not to make this too large, or the Gauge 
will have difficulty displaying it.

Font  Sets the gauge label font. This button will launch a Font Properties 
dialog. For more information about this dialog, refer to “Font Properties” on 
page A-64.

S H O W  V A L U E  L A B E L
This allows you to turn the value label on or off.

Posi tion   Sets the alignment of the gauge label. the available options include: 
Center, Left, Right, Top, and Bottom (options will depend on value of Show 
Labels On).

Font  Sets the value label font. This button will launch a Font Properties 
dialog. For more information about this dialog, refer to “Font Properties” on 
page A-64.

S H O W  L A B E L S  O N
This allows you to change where labels will be displayed. Options include Top and 
Bottom, and Left and Right.

S I Z E  L A B E L S
Allows you to size the area that the labels will be drawn in.

A U T O M A T I C A L L Y
The label area will be calculated automatically.

M A N U A L L Y
The label area will use the values specified below.
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Gauge  The total width or height (depending on the Show Labels On value), 
in pixels, of the Gauge label.

Value  The total width or height (depending on the Show Labels On value), in 
pixels, of the value label.

D R I L L - D O W N

This pane controls options for the drill-down effect of the currently selected Gauge. For 
information about Drill-down effects, refer to “Drill-down Effects” on page 7-14 of the 
PopChart Server User Guide.

D R I L L - D O W N  U R L
This is the URL (internet address) of the web page or resource to which the user will be 
forwarded when he or she clicks on a data item. You can also use JavaScript instead of a 
URL.

M E T H O D  F O R  H I G H L I G H T I N G  N O N - T E X T  I T E M S
This option changes the method for highlighting the gauge for drill-down. You can choose 
from the following options:

OutLine  A single line outlines the drill-down area as the mouse passes over it.

Bold OutLine  A double line outlines the drill-down area as the mouse passes 
over it.

C O L O R  F O R  H I G H L I G H T I N G
When drill-down is enabled for this gauge, the color of this gauge will change to the color 
shown in the color button. To change this color, click on the button. This will bring up the 
will bring up the Color Properties dialog (refer to “Color Properties” on page A-65), 
from which you can select a color.

P O P U P

This pane controls the format of PopUp text in the currently selected Gauge. PopUp text 
will appear as a user rolls his or her mouse over a gauge. For more information about PopUp 
text, refer to “PopUp Text” on page 7-12 of the PopChart Server User Guide.

J U S T I F I C A T I O N
Changes the justification of the PopUp text. Settings include: left, center, and right. The 
effects of this setting will only be seen when there are multiple lines of PopUp text.
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M A R G I N  V A L U E S
These values set the margin between the actual PopUp text and the edge of the PopUp text 
box.

Top  Sets the space in pixels between the top of the text and the top edge of the 
text box.

Left  Sets the space in pixels between the left edge of the text and the left edge of 
the text box.

Bottom  Sets the space in pixels between the bottom of the text and the bottom 
edge of the text box.

Right  Sets the space in pixels between the right edge of the text and the right 
edge of the text box.

S E T  W O R D  WR A P P I N G  WI D T H  T O
If checked, this box specifies that the PopUp text box should be no wider than the number of 
pixels indicated in the box below. If the PopUp text is wider than this value, it will 
automatically wrap and form another line inside of the PopUp text box.

S H O W  B O R D E R
If checked, the PopUp text box will be surrounded by a border.

Border Color  Allows you to change the color of the PopUp text box. Clicking 
on it brings up the Color Properties dialog (refer to “Color Properties” on 
page A-65).

F O N T
This button will launch a Font Properties dialog, where you can change the font of the 
PopUp text for the graph. For more information about this dialog, refer to “Font 
Properties” on page A-64.

A D V A N C E D

This controls advanced properties for the gauge object. For more information, refer to the 
section entitled “Advanced Object Properties” on page A-66.
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Note:  This dialog is not applicable to and therefore unavailable for Pie graphs.

This dialog controls scale properties along the value scale of certain graphs. You will see 
this dialog when you change the properties for the following scales:

These dialogs can be accessed by selecting a graph and then selecting the appropriately 
named dialog under the Properties menu. If you are looking to modify the other scale(s) 
on a graph, refer to “Bottom Scale Properties” on page A-43.

S C A L E

This pane controls the position of the scale as well as the range of its values.

P O S I T I O N  S C A L E
You can place the scale in one of the following positions (not applicable for Horizontal Bar 
graphs or the bottom scale of X-Y Plot graphs):

On Left  The scale is to the left of the graph. In radar graphs, this means that the 
scale labels will be on the left of the scale.

On Right  The scale is to the right of the graph. In radar graphs, this means that 
the scale labels will be on the right of the scale.

Line Scale Left ,  Bar Scale Right  This option will appear on the line 
scale dialog for Line Bar Combo graphs only. It sets the line scale to the left of the 
graph and the bar scale is to the right of it.

Graph Scale(s). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Vertical Bar, Line, Area, Stock Left Scale Properties or Right Scale Properties 

(depending on the position of the scale).

Horizontal Bar Bottom Scale Properties.

Line Bar Combo, Pareto Line Scale Properties and Bar Scale Properties 
(Line Bar graphs contain both a left and right scale—see 
“Line Bar Combo Graphs” on page 13-12 of the PopChart 
Server Reference manual).

X-Y Plot Left Scale Properties or Right Scale Properties 
(depending on the position of the scale), and Bottom Scale 
Properties (both scales are considered to be value scales).

Dual Y Combo Left Scale Properties and Right Scale Properties.

Radar Value Scale and Category Scale.
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Bar Scale  Left ,  Line Scale Right  This option will appear on the line 
scale dialog for Line Bar Combo graphs only. It sets the bar scale to the left of the 
graph and the line scale is to the right of it.

S Y N C  L I N E  A N D  B A R  S C A L E S ( L I N E  B A R  O N L Y )
This option is available for bar scale of Line Bar Combo graphs only. If selected, the bar 
scale will use the same scale values as the line scale.

H I D E  T H I S  S C A L E ( L I N E  B A R  O N L Y )
This option is available for bar scale of Line Bar Combo graphs only when Sync Line 
and Bar Scales is selected. If selected, the bar scale will not be displayed.

S E T  S C A L E  V A L U E S
There are two available settings for this option: Manually and Automatically. Depending 
on your selection, you will have different options available at the bottom of this dialog pane.

O P T I O N S  ( M A N U A L L Y )
This setting allows you to manually determine the range of the scale. These settings will be 
used regardless of the data values, meaning some bars, lines, and areas may be clipped.

Minimum Value  The lowest data value to be shown along the y-axis.

Maximum Value  The highest data value to be shown along the y-axis.

Number of Major Ticks  The number of major tick marks in the graph.

Number of Minor Ticks  The number of minor tick marks that occur 
between each major tick mark.

O P T I O N S  ( A U T O M A T I C A L L Y )
This setting tells PopChart Builder to automatically scale the graph using the following 
guidelines:

Maximum Major Ticks  The maximum number of major tick marks that will 
appear in the graph. The actual number of increments used may be less than this 
value.

Number of Minor Ticks  The number of small tick marks that should appear 
between each major tick.

Percent Over Max Value  The amount of space between the maximum data 
value and the top of the scale as a percentage of the maximum data value.

Set  Base of Scale  to  Zero  If checked, the bottom of the scale will always be 
set to 0, regardless of the data values.
PopChart Builder User Guide A-39
Interactive Data-Driven Graphics



D I A L O G  R E F E R E N C E

Value Scale Properties

A-40

A
. .

 . 
. .

PopChart �������
Percent Below Minimum Value  The amount of space between the 
minimum data value and the bottom of the scale as a percentage of the maximum 
data value.

U S E  L O G A R I T H M I C  S C A L E S
Checking this box sets the scale type to logarithmic.

T I C K  M A R K S

This pane allows you to control the appearance of tick marks in the currently selected graph

S H O W  M A J O R  T I C K S
If checked, a major tick mark will delimit each major increment. You can set the following 
options for this mark:

P O S I T I O N
You can position major tick marks in the following locations:

O U T S I D E   The mark will appear outside of the graph’s grid area.

I N S I D E   The mark will appear inside of the graph’s grid area.

C R O S S   The mark will appear both outside and inside of the graph area so that it 
looks like a cross.

S I Z E
The mark can appear in one of three sizes: Small, Medium, or Large.

C O L O R
The color button will launch a Color Properties dialog, where you can change 
the color used for major tick marks. For more information about this dialog, refer to 
“Color Properties” on page A-65.

S H O W  M I N O R  T I C K S
If checked, a minor tick mark will delimit each minor increment. You can set the following 
options for this mark:

P O S I T I O N
You can position minor tick marks in the following locations:

O U T S I D E   The mark will appear outside of the graph’s grid area.

I N S I D E   The mark will appear inside of the graph’s grid area.
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C R O S S   The mark will appear both outside and inside of the graph area so that it 
looks like a cross.

S I Z E
The mark can appear in one of three sizes: Small, Medium, or Large. Note that 
minor tick mark sizes are relatively smaller than major tick mark sizes: a minor tick 
mark will appear smaller than a major tick marks of the same size.

C O L O R
The color button will launch a Color Properties dialog, where you can change 
the color used for minor tick marks. For more information about this dialog, refer to 
“Color Properties” on page A-65.

L A B E L

This dialog pane allows you to change the settings for scale labels.

D I S P L A Y  S C A L E  L A B E L S
If checked, scale labels will appear to the left (or right, if the scale is on the right) of each 
major tick mark.

N U M B E R  F O R M A T
These settings affect the numerical format of the graph’s scale labels.

D I S P L A Y  L A B E L  A S
A label can be displayed in one of several different formats:

General   Only the number itself will be shown.

Currency  The number will be shown with the PopChart’s currency symbol. For 
example, 5 might be displayed as $5. See also: “Currency Symbol.”

Percentage  A percentage sign % will follow the number.

N E G A T I V E  V A L U E S
If the data value is negative, the graph will use this setting to determine how to 
display it. It can be displayed either as a minus sign -, in parenthesis ( ), or as an 
absolute value (no negative value indicator).

A L W A Y S  S H O W  D E C I M A L  P L A C E S
If this is checked, the number will always be shown as a decimal, regardless of 
whether it was entered into the Data Editor as such. It will be shown to as many 
places as indicated in the Decimal Places property.
PopChart Builder User Guide A-41
Interactive Data-Driven Graphics



D I A L O G  R E F E R E N C E

Value Scale Properties

A-42

A
. .

 . 
. .

PopChart �������
D E C I M A L  P L A C E S
The number of decimal places to show. Data values that have more decimal places 
will be rounded to the nearest decimal at this point.

S H O W  T H O U S A N D S  S E P A R A T O R
Specifies whether or not to show a thousands separator. For example, if a comma is 
used as the thousands separator (see “Thousands”), one million will be shown as 
1,000,000 when this box is checked. Otherwise, one million would be shown as 
1000000.

S C A L E  L A B E L  A B B R E V I A T I O N
These settings control how the scale labels will be abbreviated.

A U T O  A B B R E V I A T E
PopChart will automatically abbreviate the scale labels. It will usually abbreviate 
it so that there are no more than three digits in the scale label. For example, 1,000 
becomes 1k, while 56,500,000 becomes 56.5M.

M A N U A L L Y  A B B R E V I A T E
You decide how the labels should be abbreviated. 

Display Value As  This setting changes the how the numbers will be 
displayed. It determines what number the scale labels will be relative to. If set to 
Unchanged, they will be displayed normally. However, if set to Thousands, 
560 would be displayed as .56, since it is 56/100 of one thousand. Likewise, 
4,125,375 would appear as 4.125 if it were displayed as Millions. If set to 
Percentage, .08 would appear as 8, or as 8% if Display Label As is also set to 
Percentage. Other options include Billions and Trillions.

Show Abbreviat ion  If this is checked, all numbers will be followed by an 
abbreviation to indicate what the numbers are relative to. For example, 10 
displayed as Thousands with an abbreviation might be .01k. When you are 
displaying a value as a Percentage and check this box, the number will always be 
followed by a percentage % sign, regardless of what Display Label As is set to For 
information on setting the abbreviation, refer to “Abbreviation Characters” on 
page A-21.

R O T A T E  L A B E L S
When checked, the scale labels will be rotated by the value shown in the text box to the 
right.

F O N T

Specifies font characteristics for the left or right scale. For more information, refer to the 
section entitled “Font Properties” on page A-64.
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Note:  This dialog is not applicable to and therefore unavailable for Pie graphs.

This dialog controls scale properties along the x-axis (or y-axis in the case of Horizontal Bar 
graphs) of the currently selected graph object. It is accessed by selecting a graph amd then 
selecting Properties > Bottom Scale Properties (or Left Scale Properties for 
Horizontal Bar graphs).

X-Y Plot and Horizontal Bar graphs use the Value Scale Properties dialog for what 
appears to be the bottom scale. Refer to “Value Scale Properties” on page A-38 for 
information on modifying the bottom scale for these graph types.

This scale is also known as the “Category Scale,” since each discrete point along it 
represents a category of data.

T I C K  M A R K S

This pane controls tick marks for the currently selected graph’s bottom scale.

S H O W  T I C K  M A R K S
If checked, tick marks will be shown between each scale label along the bottom of the 
graph. You can set the following options for these marks:

P O S I T I O N
You can position tick marks in the following locations:

Outside  The mark will appear outside of the graph’s grid area.

Inside  The mark will appear inside of the graph’s grid area.

Cross   The mark will appear both outside and inside of the graph area so that it 
looks like a cross.

S I Z E
The mark can appear in one of three sizes: Small, Medium, or Large.

C O L O R
The color button will launch a Color Properties dialog, where you can change 
the color used for bottom scale tick marks. For more information about this dialog, 
refer to “Color Properties” on page A-65.
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L A B E L

This dialog pane allows you to change the settings for scale labels.

D I S P L A Y  S C A L E  L A B E L S
If checked, scale labels will be displayed for each category that is being graphed.

L I M I T  L A B E L  C H A R A C T E R  L E N G T H
Limits the character length of each scale (category) label to the specified number. If the 
label is longer, it will truncate it and add a period on the end. This period counts as part of 
the character length.

M A X  L E N G T H  H O R I Z O N T A L  T E X T
Sets the maximum number of characters in the category label when it is not rotated.

M A X  L E N G T H  R O T A T E D  T E X T
Sets the maximum number of characters in the category label when it is rotated.

F I R S T  L A B E L  T O  B E  D I S P L A Y E D
This specifies the number of the first bottom scale label that will actually be shown.

P E R F O R M  T H E  F O L L O W I N G  A D J U S T M E N T S
Allows you to select how the following category label adjustments are applied. The options 
are As Needed and Always. For a description of how these options behave, refer to 
“Scale Label Adjustments” on page 1-22.

W R A P  T E X T  T O  M A X  N U M B E R  O F  L I N E S  When selected, the text in 
the scale label will be wrapped to the specified number of lines (if needed).

S H R I N K  F O N T  T O   This rule applies only when As Needed has been 
selected. If this rule is applied, PopChart will attempt to shrink the font of the scale 
labels down to the font point size specified in the box to the right of this option.

S T A G G E R  L A B E L S  This rule applies only when As Needed has been 
selected. If this rule is applied, PopChart will attempt to stagger the labels so that 
every other one appears on an alternate level.

R O T A T E  L A B E L S   If this rule is applied, PopChart will rotate the scale labels 
by the specified number of degrees. This will usually significantly decrease the 
vertical size of the graph, unless Limit Label Character Length has been 
enabled or Keep Text and Ticks Within Graph Bounds has been unchecked 
in the Graph Properties > General dialog pane (refer to “Keep Text and 
Ticks Within Graph Bounds” on page A-24).
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S K I P  X  L A B E L S  A T  A  T I M E   This rule specifies that a certain number of 
labels should be skipped altogether. The bar, line, area, or plot point will still be 
shown for that category, but the scale label will not. The graph will use the number 
in the box to determine the increment between each shown bottom label. For 
example, if the value is 1, it will display every other label. If the value is 2, it will 
display every third label. If the value is 0, it will skip nothing.

F O N T

Specifies font characteristics for the bottom scale. For more information, refer to the section 
entitled “Font Properties” on page A-64.
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Note:  This scale only exists in Radar graphs.

This dialog controls the category scale for a radar graph. The category scales occur at each 
compass point in the radar graph.

L A B E L

This dialog pane allows you to change the settings for category scale labels.

D I S P L A Y  S C A L E  L A B E L S
If checked, scale labels will be displayed for each category that is being graphed.

L I M I T  L A B E L  C H A R A C T E R  L E N G T H
Limits the character length of each scale (category) label to the specified number. If the 
label is longer, it will truncate it and add a period on the end. This period counts as part of 
the character length.

F I R S T  L A B E L  T O  B E  D I S P L A Y E D
This specifies the number of the first bottom scale label that will actually be shown.

W R A P  T E X T  I F  O V E R
When selected, the text in the scale label will be wrapped at the specified number of pixels.

F O N T

Specifies font characteristics for the bottom scale. For more information, refer to the section 
entitled “Font Properties” on page A-64.
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This dialog controls the appearance of data labels. Data labels are boxes of text that usually 
appear above a data item. The dialog can be selected by double-clicking on any data label, 
or by selecting graph and then selecting Properties > Data Label Properties.

G E N E R A L

This dialog pane allows you to specify general properties for your data labels.

S H O W  D A T A  L A B E L S
Specifies when the graph will display data labels. The available options are:

Never  The graph will never display data labels.

Always  The graph will always display data labels.

On Rollover  The graph will display data labels only when a user “rolls over” 
the corresponding bar, line, or wedge with their mouse pointer.

Note:  When you use roll-over data labels, the letters RO will appear in the data label boxes while 
you are in the PopChart Builder interface. This is to indicate that the boxes will only 
appear as the user rolls his or her mouse over the data item.

P O S I T I O N
Sets the location of the graph’s data labels. Depending on the graph type, different options 
will be available. The image to the right of this setting indicates the effect of the various 
options. These options include the following:

Above Line /  Point   The data label will appear above the line or data item.

Below Line /  Point  The data label will appear below the line or data item.

Outside  Top /  Right   The data label will appear above the bar (or to the right 
for a horizontal bar).

Inside Top /  Right  The data label will appear just below the top of the bar (or 
just to the left of the right end of a horizontal bar).

Inside Bottom /  Left   The data label will appear at the bottom of the bar (or at 
the left end of a horizontal bar).

Out w/Leader on Sides  The data label will appear just below the top of the 
bar (or just to the left of the right end of a horizontal bar).
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Out w/ Leader  The data label will appear at the bottom of the bar (or at the left 
end of a horizontal bar).

Out  The data label will appear just below the top of the bar (or just to the left of 
the right end of a horizontal bar).

Inside  The data label will appear at the bottom of the bar (or at the left end of a 
horizontal bar).

D A T A  L A B E L  F O R M A T ( A L L  G R A P H S  E X C E P T  P I E )
This controls how the text in your data labels will appear. Your data format string can 
include regular text, such as a currency symbol or percent character, or it can include any of 
the data-specific macros listed in the Value Keywords pull-down menu.

For information about the data label format string and macros, refer to “Custom Data 
Label Formatting” on page 1-12.

V A L U E  K E Y W O R D S ( A L L  G R A P H S  E X C E P T  P I E )
This is a list of macros that can be used in the data label format string. You can insert any of 
these macros into the data label format string by selecting the appropriate macro and 
clicking on the Insert button. A complete list of these macros is available in Table 1.1 on 
page 1-13.

S H O W  B O R D E R
Specifies whether or not the data label should have a border. You can control the color of 
this border by clicking on the Color button next to it, which will launch a Color 
Properties dialog (refer to “Color Properties” on page A-65).

M A X I M U M  W I D T H ( A L L  G R A P H S  E X C E P T  P I E )
The maximum width of the data label. If the data label exceeds this width, it will be 
wrapped.

S H O W  O N E  D A T A  L A B E L  F O R  E A C H  C A T E G O R Y ( A R E A ,  
S T A C K E D  B A R )
In an area or stacked bar, you can either show a data label for each data segment, or you can 
show a data label for the entire stacked bar or area. Check this box if you want to show just 
one data label for the entire stacked bar or area.

S H O W  V A L U E  A S ( P I E  G R A P H S  O N L Y )
This setting affects how the data value is shown. The options available will depend on the 
graph type:

Actual  Value  The default setting, this means that the value will appear just as it 
was entered into the graph’s spreadsheet.
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Percentage of  Total   The graph will show each data value as a percentage of 
the sum of all data values in the entire graph.

S H O W  S E R I E S  T E X T ( P I E  G R A P H S  O N L Y )
This setting allows you to add the series label to the data label for each wedge in a pie graph. 
The image above this setting, which changes as you make changes, shows you how the 
graph will appear with the currently selected setting. Available options include:

Value Only  This is the default setting. Only the data value will be in the data 
label.

Name Only  Only the series label will be in the data label.

Name and Value  The data value and the series label will both be in the data 
label.

Name Outside,  Value Inside  The series label will appear outside of the 
pie, while the value will appear inside of it.

Name above,  value on graph  (Roll-over labels only) The series label will 
appear above the pie, while the value will appear as specified in the Position 
setting.

Name below, value on graph  (Roll-over labels only) The series label will 
appear below the pie, while the value will appear as specified in the Position 
setting.

Name and value above  (Roll-over labels only) Both the series label and data 
value will appear above the pie.

Name and value below  (Roll-over labels only) Both the series label and data 
value will appear below the pie.

N U M B E R  F O R M A T ( P I E  G R A P H S  O N L Y )
These settings affect the numerical format of the graph’s data labels.

D I S P L A Y  V A L U E  A S
This allows you to specify how a data label will be displayed in a pie graph. The 
options are: General, Currency, and Percentage.

N E G A T I V E  V A L U E S
If the data value is negative, the graph will use this setting to determine how to 
display it. It can be displayed either as a minus sign -, in parenthesis ( ), or as an 
absolute value (no negative value indicator).
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A L W A Y S  S H O W  D E C I M A L  P L A C E S
If this is checked, the number will always be shown as a decimal, regardless of 
whether it was entered into the spreadsheet as such. It will be shown to as many 
places as indicated in the Decimal Places property.

D E C I M A L  P L A C E S
The number of decimal places to show. Data values that have more decimal places 
will be rounded to the nearest decimal at this point.

S H O W  T H O U S A N D S  S E P A R A T O R
Specifies whether or not to show a thousands separator. For example, if a comma is 
used as the thousands separator (see “Thousands”), one million will be shown as 
1,000,000 when this box is checked. Otherwise, one million would be shown as 
1000000.

F O N T

Specifies font characteristics for data labels. For more information, refer to the section 
entitled “Font Properties” on page A-64.

V A L U E  F O R M A T ( A L L  G R A P H S  E X C E P T  P I E )

This dialog pane controls the format of the data value in the data label. 

N U M E R I C  F O R M A T
This setting affects the numerical format of the value returned by any macros that return 
values (e.g. %_VALUE).

N E G A T I V E  V A L U E S
If the data value is negative, the graph will use this setting to determine how to 
display it. It can be displayed either as a minus sign -, in parenthesis ( ), or as an 
absolute value (no negative value indicator).

A L W A Y S  S H O W  D E C I M A L  P L A C E S
If this is checked, the number will always be shown as a decimal, regardless of 
whether it was entered into the spreadsheet as such. It will be shown to as many 
places as indicated in the Decimal Places property.

D E C I M A L  P L A C E S
The number of decimal places to show. Data values that have more decimal places 
will be rounded to the nearest decimal at this point.
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S H O W  T H O U S A N D S  S E P A R A T O R
Specifies whether or not to show a thousands separator. For example, if a comma is 
used as the thousands separator (see “Thousands”), one million will be shown as 
1,000,000 when this box is checked. Otherwise, one million would be shown as 
1000000.

P E R C E N T A G E  F O R M A T
These setting affects the numerical format of the value returned by the 
%_PERCENT_OF_CATEGORY and %_PERCENT_OF_TOTAL data label macros.

A L W A Y S  S H O W  D E C I M A L  P L A C E S
If this is checked, the percentage will always be shown to number of decimal places 
indicated in the Decimal Places property.

D E C I M A L  P L A C E S
The number of decimal places to show. Percentages that have more decimal places 
will be rounded to the nearest decimal at this point.
PopChart Builder User Guide A-51
Interactive Data-Driven Graphics



D I A L O G  R E F E R E N C E

Series Properties

A-52

A
. .

 . 
. .

PopChart �������
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S E R I E S  P R O P E R T I E S

This dialog allows you to control properties that are specific to the currently selected series 
of data. To access this dialog, select a graph and then select Properties > Series 
Properties.

S E L E C T E D  S E R I E S

This setting is located in the upper right hand corner of the Series Properties dialog 
window. It shows the name of the currently selected data series. You can use its pull-down 
menu to change the currently selected series. This is especially useful for copying and 
pasting information between series.

G E N E R A L

This pane controls general options for the series such as the series color. 

Note:  This pane will not appear if you are using a bar chart with the Single Series Multicolor 
Mode (Bar) enabled and there is only one series of data.

C O L O R
The color button will launch a Color Properties dialog, where you can change the color 
used for the series (bars, lines, pie wedges, etc.). For more information about this dialog, 
refer to “Color Properties” on page A-65.

L I N E  C O L O R ( P A R E T O  O N L Y )
The color button will launch a Color Properties dialog, where you can change the color 
used for the line in a Pareto graph. For more information about this dialog, refer to “Color 
Properties” on page A-65.

D I S P L A Y  S E R I E S  U S I N G ( L I N E ,  X - Y  P L O T ,  T I M E  P L O T ,  
R A D A R )
This option is only available for line or x-y plot elements in a graph. This lets you change 
how the series is displayed.

Line  IYou can add a line for this series by checking the Line box. You can 
change the thickness of the series line by selecting a new Width from the pull-
down menu to the right. You can also change the symbol color by clicking on the 
Color button below this setting.

Symbols  You can add a line for this series by checking the Symbol box. You 
can change the symbol (or add a symbol to each plot point in the series when you 
PopChart Builder User Guide
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are using a Line, X-Y, or Time Plot graph. The Type pull-down menu on the right 
gives you a variety of options, including squares, triangles, circles, crosses, or no 
symbol at all. You can also change the symbol color by clicking on the Color 
button below this setting.

Bubble  IIf the graph allows for a bubble, you can add a bubble for this series by 
checking the Bubble box. You can change the look of your bubble by selecting a 
new Type from the pull-down menu to the right. the options include 3D, Fill 
only, Outline only, and Outline and Fill. You can change the bubble fill color 
by clicking on the Color button below this setting. You can also change the color 
of the outline by clicking on the Outline color button below the pull-down menu.

Filled  Area  If a graph allows for a fill area, you can add a fill area for the series 
by checking the Filled area box. A fill area will appear underneath the line for the 
series. You can change the color of the filled area by clicking on the Color button 
below this setting.

M O V I N G  U P  I N D I C A T O R ( C A N D L E S T I C K  O N L Y )
The moving up indicator in a Candlestick graph appears for data items whose value has 
risen for the day (the data item’s close value was higher than its open value). You can 
change the colors for moving up indicators by clicking on the Fill Color and Outline Color 
buttons. This launches a Color Properties dialog, where you can change the color used 
for the fill or outline color.

M O V I N G  D O W N  I N D I C A T O R ( C A N D L E S T I C K  O N L Y )
The moving down indicator in a Candlestick graph appears for data items whose value has 
fallen for the day (the data item’s close value was lower than its open value). You can 
change the colors for moving up indicators by clicking on the Fill Color and Outline Color 
buttons. This launches a Color Properties dialog, where you can change the color used 
for the fill or outline color.

C O L O R  I F  M O V I N G  U P ( H I G H - L O W / O P E N - C L O S E  O N L Y )
The moving up indicator in a High-Low/Open-Close graph appears for data items whose 
value has risen for the day (the data item’s close value was higher than its open value). You 
can change the colors for moving up indicators by clicking on this file. This launches a 
Color Properties dialog, where you can change the color used for the stock bar.

C O L O R  I F  M O V I N G  D O W N ( H I G H - L O W / O P E N - C L O S E  O N L Y )
The moving down indicator in a High-Low/Open-Close graph appears for data items whose 
value has fallen for the day (the data item’s close value was lower than its open value). You 
can change the color for moving up indicators by clicking on this button. This launches a 
Color Properties dialog, where you can change the color used for the stock bar.
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D A T A  L A B E L S

This dialog pane allows you to change the data label format string for data labels in this 
series. This overrides any settings from the Data Label Properties dialog.

D A T A  L A B E L  F O R M A T
This controls how the text in your data labels will appear. Your data format string can 
include regular text, such as a currency symbol or percent character, or it can include any of 
the data-specific macros listed in the Value Keywords pull-down menu.

For information about the data label format string and macros, refer to “Custom Data 
Label Formatting” on page 1-12.

V A L U E  K E Y W O R D S
This is a list of macros that can be used in the data label format string. You can insert any of 
these macros into the data label format string by selecting the appropriate macro and 
clicking on the Insert button. A complete list of these macros is available in Table 1.1 on 
page 1-13.

D R I L L - D O W N  U R L S

This pane allows you to set the drill-down destination for each item in the currently selected 
series. A drill-down destination can be either a URL or JavaScript command (e.g. 
javascript:myfunction()).

Note:  Because Drill-down is usually context sensitive, you probably don’t want to set PopUp text 
in an appearance file if you will be using that appearance file for dynamic data.

This pane consists of a table that lists every item in the series along with its drill-down 
destination. This table contains the following fields:

N A M E   The name of the item whose drill-down URL you are changing. This 
corresponds to the category name for that item. This value can be changed in the 
Data Editor.

V A L U E  The data value of the item. This value can be changed in the Data 
Editor.

D R I L L - D O W N  U R L  This is the URL (internet address) of the web page or 
resource to which the user will be forwarded when he or she clicks on the data item. 
You can also use JavaScript instead of a URL. If you have set a global drill-down 
URL for the graph in the Graph Properties > Drill-down dialog, the value you 
set here will replace the global setting.
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P O P U P  T E X T

This pane allows you to set PopUp text for each item in the currently selected series.

Note:  Because PopUp text is usually context sensitive, you probably don’t want to set PopUp text 
in an appearance file if you will be using that appearance file for dynamic data.

This pane consists of a table that lists every item in the series, along with its PopUp text 
string. This table contains the following fields:

N A M E   The name of the item whose PopUp text you are changing. This 
corresponds to the category name for that item. This value can be changed in the 
Data Editor.

V A L U E  The data value of the item. This value can be changed in the Data 
Editor.

P O P U P  T E X T   This is the PopUp text string that will be displayed as the user 
moves his or her mouse over the currently selected item. It can be edited directly in 
this pane.

N O T E  T E X T

This pane allows you to set PopChart Notes for each item in the currently selected series.

Note:  Because Notes are usually context sensitive, you probably don’t want to set a Note in an 
appearance file if you will be using that appearance file for dynamic data.The only 
exception to this is if you are creating a Static Note box, as described in “Using Static 
PopChart Notes” on page 1-17.

This pane consists of a table that lists every item in the series, along with its Note. This table 
contains the following fields:

N A M E   The name of the item whose Note you are changing. This corresponds to 
the category name for that item. This value can be changed in the Data Editor.

V A L U E  The data value of the item. This value can be changed in the Data 
Editor.

N O T E   This is the Note that will be attached to the indicated data item. It can be 
edited directly in this pane.
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This dialog controls settings for the currently selected legend object. To access this dialog, 
select a legend and then select Properties > Legend Properties.

G E N E R A L

This dialog pane controls general options for the formatting of a legend.

L A Y O U T  I T E M S
This option allows you to control the order by which series names are listed in the legend. 
For example, when this value is set to Left to Right, the second series name will be listed 
to the right of the first. When this value is set to Top to Bottom, the second series name 
will be listed below the first series name. If there is only one row or series of items in the 
legend, this setting has no effect.

G R O W  V E R T I C A L L Y  I F  N E E D E D
If the legend cannot display all of the legend items within its bounds, this setting allows 
PopChart to expand the legend to the height specified on the right. If the legend does not 
need to be expanded all the way to this height to fit the legend items, it will not be expanded. 
The expansion will take place before PopChart Server attempts to apply the Minimum 
Font Size and Truncate Down to X Characters settings.

G R O W  H O R I Z O N T A L L Y  I F  N E E D E D
If the legend cannot display all of the legend items within its bounds, this setting allows 
PopChart to expand the legend to the width specified on the right. If the legend does not 
need to be expanded all the way to this width to fit the legend items, it will not be expanded. 
The expansion will take place before PopChart Server attempts to apply the Minimum 
Font Size and Truncate Down to X Characters settings.

P R E F E R E N C E S
These options control how the legend is formatted.

S E T  N U M B E R  O F  C O L U M N S  T O
This manually sets the number of columns that should be in the legend. This 
number will only be overridden when there is not enough space (after resizing and 
other adjustments) to display the legend.

M I N I M U M  F O N T  S I Z E
This is the smallest size that the legend font can be shrunk to. If there is not enough 
room in the legend for all of the legend items, PopChart will shrink the legend font 
size to no smaller than this size in order to fit all of the items.
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T R U N C A T E  D O W N  T O  X  C H A R A C T E R S
If, after shrinking the font size, there is still not enough room for all of the legend 
items, the series names will be truncated to the number of characters specified in 
this setting. This number includes a period. For example, if this value is 5, January 
would become Janu..

L E G E N D  M A R K E R  S I Z E
Controls the size of the legend marker. The legend marker is the small color box that 
appears to the left of the series name.

S C A L E  T O  F O N T
The size of the legend marker will be the same as the size of the font (i.e. the height 
of the legend marker is the height of the font).

S E T  T O
This allows you to manually set the width and height, in pixels, of the legend 
marker.

F O N T

Specifies font characteristics for the legend object. You can also change the background 
color for the legend in the Font pane. For more information, refer to the section entitled 
“Font Properties” on page A-64.

B O R D E R S  &  S H A D O W

This pane allows you to control border and shadow settings for the currently selected 
legend.

B O R D E R  T Y P E
Sets the legend border type. Available options include:

• None

• Thin

• Regular

• Thick

• Double Thin

• Double - Thick Inside, Thin Outside

• Double - Thin Inside, Thick Outside
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B O R D E R  C O L O R
Sets the legend border color. For more information about this dialog, refer to “Color 
Properties” on page A-65.

S H A D O W T Y P E
Sets the legend shadow type. You can choose either None, or from six shadow depths.

S H A D O W C O L O R
Sets the legend shadow color. For more information about this dialog, refer to “Color 
Properties” on page A-65.

A D V A N C E D

This controls advanced properties for the legend object. For more information, refer to the 
section entitled “Advanced Object Properties” on page A-66.
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This dialog controls settings for the currently selected text box object. To access this dialog, 
select a text box and then select Properties > Text Box Properties.

G E N E R A L

This pane controls general settings for the currently selected text box, such as the actual text 
and the justification.

T E X T
The text that will go into the text box.

J U S T I F I C A T I O N
Changes the justification of the text inside the text box. Settings include Left, Center, and 
Right.

M A R G I N  V A L U E S
Sets the size of the margin between the text inside of the text box and the edge of the text 
box.

Note:  Margins on rotated text are relative to how the text is read in the text box.

Top  The margin, in pixels, between the top of the text and the top edge of the text 
box.

Left  The margin, in pixels, between the left edge of the text and the left edge of 
the text box.

Bottom  The margin, in pixels, between the bottom of the text and the bottom 
edge of the text box.

Right  The margin, in pixels, between the right edge of the text and the right edge 
of the text box.

R O T A T E  T E X T
Allows you to rotate the currently selected text box.

None  The text box will not be rotated.

Clockwise  The text box will be rotated clockwise ninety degrees.
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CounterClockwise  The text box will be rotated counter-clockwise ninety 
degrees.

A U T O  S I Z E  A D J U S T M E N T
If the text in the text box is smaller than the text box and one of these options is set, the text 
box will shrink so that the text box is the same size as the text plus the margins. This is an 
especially useful setting for appearance files that will be used dynamically with PopChart 
Server Pro.

Shrink to Width  The width of the text box will be shrunk to match the width 
of the text.

Shrink to Height  The height of the text box will be shrunk to match the 
height of the text.

Max Width  If Shrink to Width is checked, the text box will be no larger than 
the number of pixels specified in this box. Text will wrap to a new line if wider than 
this.

O N L Y  D I S P L A Y  T E X T B O X  A S  A  N O T E
If checked, PopChart Server will only display this text box when it is attached to a 
PopChart Note. For more information, refer to the section entitled “Attaching PopChart 
Notes to Text Boxes” on page 1-16.

F O N T

Specifies font characteristics for the text box object. You can also change the background 
color for the text box in the Font pane. For more information, refer to the section entitled 
“Font Properties” on page A-64.

B O R D E R S  &  S H A D O W

This pane allows you to control border and shadow settings for the currently selected text 
box.

B O R D E R  T Y P E
Sets the text box border type. Available options include:

• None

• Thin

• Regular

• Thick
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• Double Thin

• Double - Thick Inside, Thin Outside

• Double - Thin Inside, Thick Outside

B O R D E R  C O L O R
Sets the text box border color. For more information about this dialog, refer to “Color 
Properties” on page A-65.

S H A D O W T Y P E
Sets the text box shadow type. You can choose either None, or from six shadow depths.

S H A D O W C O L O R
Sets the text box shadow color. For more information about this dialog, refer to “Color 
Properties” on page A-65.

A D V A N C E D

This controls advanced properties for the text box object. For more information, refer to the 
section entitled “Advanced Object Properties” on page A-66.
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This dialog controls the properties of images that you have imported into PopChart 
Builder.

G E N E R A L

This dialog pane controls general properties for your imported image.

T R A N S P A R E N C Y
You can the transparency of your image by sliding the transparency bar or entering a 
number. 100% means that the object is solid, while 0% means that the image is invisible. 
The image above the transparency bar will help indicate the effect of your setting.

P I C T U R E  S I Z E
This allows you to set the size of your imported image.

W I D T H
This is the width of your imported image.

H E I G H T
This is the height of your imported image.

C O N S T R A I N  P R O P O R T I O N S
If this box is checked, PopChart Builder will maintain the aspect ration of your image 
when you change the width or height.

R E S T O R E  T O  D E F A U L T  S I Z E
When you click on this button, PopChart Builder will restore the image to its original size.

B O R D E R

Controls the image border settings.

B O R D E R  T Y P E
Sets the image border type. Available options include:

• None

• Thin

• Regular

• Thick
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• Double Thin

• Double - Thin Inside, Thick Outside

• Double - Thick Inside, Thin Outside

C O L O R
Sets the project border color.

D R I L L - D O W N

This pane controls options for the drill-down effect of the currently selected imported 
image. For information about Drill-down effects, refer to “Drill-down Effects” on page 7-14 
of the PopChart Server User Guide.

D R I L L - D O W N  U R L
This is the URL (internet address) of the web page or resource to which the user will be 
forwarded when he or she clicks on the image. You can also use JavaScript instead of a 
URL.

M E T H O D  F O R  H I G H L I G H T I N G
This option changes the method for highlighting the image when it has been enabled for 
drill-down effects. You can choose from the following options:

OutLine  A single line outlines the drill-down area as the mouse passes over it.

Bold OutLine  A double line outlines the drill-down area as the mouse passes 
over it.

C O L O R  F O R  H I G H L I G H T I N G
When drill-down is enabled for an, the color of the border area around it will change to the 
color shown in the color button. To change this color, click on the button. This will bring up 
the will bring up the Color Properties dialog (refer to “Color Properties” on page A-65), 
from which you can select a color.

A D V A N C E D

This controls advanced properties for the bitmap object. For more information, refer to the 
section entitled “Advanced Object Properties” on page A-66.
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This dialog or dialog pane occurs frequently in PopChart Builder. Most dialogs allow you 
to change the following font properties:

F O N T   The font type. PopChart Builder automatically includes these types: 
TimesRoman, Helvetica, Courier, and Lucida. You can also use any custom 
fonts you have set.

F O N T  S T Y L E  The font style. For each font type, you can choose the following 
styles: Regular, Italic, Bold, Bold Italic.

S I Z E   The font size.

T E X T  C O L O R   Launches the Color Properties dialog, where you can 
change the font color. For more information about this dialog, refer to “Color 
Properties” on page A-65.

B A C K G R O U N D  C O L O R   Launches the Color Properties dialog, where 
you can change the background color for the font. For more information about this 
dialog, refer to “Color Properties” on page A-65. This option will not be available 
for Data Labels or Scale Labels.

T R A N S P A R E N T  B A C K G R O U N D   If checked, the background of the font 
will be transparent. This option will not be available for Data Labels, Scale Labels, 
or PopUp Text.

P R E V I E W   This box shows how the font will appear under the current settings.
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This dialog allows you to modify the color of the currently selected item. You can select 
preset or recently used colors through the Swatches tab. You can customize the color 
using one of the middle three tabs. The text and graphics at the bottom of the dialog allow 
you to preview your new color.

If you want to make a color translucent or transparent, you can edit its alpha value in the 
Transparency tab. Setting the alpha value to 0 will make the color solid, while 255 will 
make the color invisible. Set the color somewhere in between for translucency. When a 
color is translucent, you will be able to see objects behind any item that uses that color.
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Each object in a appearance file has certain advanced properties that will not normally be 
changed by a user. These properties are usually only applicable for appearance files built for 
PopChart Server.

O B J E C T  T Y P E
An object can be one of three types: Graph, Legend, or TextBox. You can not change 
this setting.

O B J E C T  N A M E
If a project is going to be used with PopChart Server, each object inside of it should have 
a unique name. This name will be used for reference as you send your dynamic data to 
PopChart Server.

O B J E C T  P O S I T I O N
This specifies the position and size of the currently selected object in the appearance file. 
Normally, you’ll want to move and resize the object with your mouse. However, if you need 
more precision, changing these settings with this dialog may be helpful.

Top  The y coordinate, in pixels, of the top edge of the object.

Left  The x coordinate, in pixels, of the left edge of the object.

Height  The height, in pixels, of the object.

Width  The width, in pixels, of the object.

A N C H O R S
This specifies where to anchor the currently selected object. Anchors determine how the 
object will grow or shrink as the data in the object is modified. This is an especially useful 
control mechanism for templates and appearance file being used as appearance files for 
PopChart Server. In both cases, objects usually grow, shrink, or are repositioned 
dynamically. By anchoring an object, you can be sure that it will stay where you want it to 
stay. For example, if you anchor the graph to the Center vertically and Left horizontally, 
you can be sure that the vertical center of the graph will always be in the same spot and that 
the left edge of the graph will always be in the same spot.

Vertical   You can anchor your object vertically in one of three positions: Top, 
Center, or Bottom.

Horizontal  You can anchor your object horizontally in one of three positions: 
Left, Center, or Right.
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